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Welcome

Thank you for choosing the Xerox CopyCentre C20,

WorkCentre M20 or WorkCentre M20i. These products have
been designed for ease of use, but to use your machine to its

fullest potential take some time to read the User Guide.

> Introduction . ........ ... ... 1-2
> AboutThisGuide.......................... 1-3
> Related Information Sources. . ............... 1-4
> CustomerSupport............ ... ... ..... 1-5
> Safety ... 1-6
> Regulatory Infformation . .................... 1-9
> Regulations-Europe...................... 1-14
> Regulations-USA........................ 1-15
> Regulations-Canada ..................... 1-17
> Environmental Compliance . ................ 1-18
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Welcome

Introduction

® For instructions
on unpacking and
setting up the
machine ready for
use the Quick
Install Sheets, or
refer to “Getting
Started” on page
2-1.

The Xerox CopyCentre C20, WorkCentre M20 or WorkCentre M20i are a family of digital
devices capable of being used for copying, printing, faxing, scanning and e-mail. The features
and functions available on your machine depend on the model purchased:

Xerox CopyCentre C20

This model is a digital copier and copies at 21 pages per minute. It comes with a Document
Feeder, Paper Tray and Bypass Tray as standard and also provides 2 Sided copying.

An additional Paper Tray, Foreign Interface, Cabinet and Stand are available as options.

Xerox WorkCentre M20

This model provides digital copying, direct printing and direct scanning. It copies and prints at
21 pages per minute. A Document Feeder, Paper Tray and Bypass Tray are also provided
and 2 Sided copying and printing is supported.

An additional Paper Tray, a Foreign Interface, a Cabinet and Stand and Network Printing are
available as options.

Xerox WorkCentre M20i

This model has digital copying, direct scanning, and faxing capabilities. It also provides
networked printing and e-mail.

A Document Feeder and a single Paper Tray are supplied as standard, and 2 Sided capability
is also supported. An additional Paper Tray, a Foreign Interface, and a Cabinet and Stand are
available as options.

Documentation and software is provided to support the networked capability and an additional
32MB memory is supplied with the e-mail function.
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About This Guide

Throughout this User Guide some terms are used interchangeably:

> Paper is synonymous with media.

» Document is synonymous with original.

» Xerox CopyCentre C20, WorkCentre M20 or WorkCentre M20i is synonymous with the

machine.

The following table offers further information about the conventions used within this Guide.

In addition, references to other
publications are displayed in Italic
typeface.

CONVENTION DESCRIPTION EXAMPLE
Italic Typeface Used to emphasise a word or phrase. | Xerox CopyCentre C20, WorkCentre
M20 or WorkCentre M20i.

provide additional or useful
information about a function or
feature.

Bracket Text Typeface |Used to emphasise the selection of a |> Select the paper supply source
feature mode or key. required by pressing [Paper
Supply].
Notes Located in the margins and used to | ® For instructions on loading media, refer

to “Loading Paper” on page 4-2.

Specification Note

Provides more in-depth specification
information relating to the machine.

®  For full media specifications refer to
“Media Specifications” on page 12-7.

personal injury.

Caution Cautlon§ are statements that suggest CAUTION: DO NOT use organic or
mechanical damage as a result of an .
) strong chemical solvents or
action. aerosol cleaners or pour fluids
directly onto any area.
Warning Used to alert users to the possibility of

WARNING: This product must be
connected to a protective earthing
circuit.

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide
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Related Information Sources

Information available for the products consists of:
- This User Guide
- The Quick Start Guide
- The Quick Install Sheets
- The System Administration Guide

- The Xerox website http.//www.xerox.com
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Customer Support

If you need assistance during or after product installation, please visit the Xerox website for
online solutions and support:

http://www.xerox.com

If you require further assistance, call our experts at the Xerox Welcome Center, or contact your
local representative. When telephoning please quote the machine serial number. Use the
space below to make a note of the machine serial number:

#

To access the serial number open the side cover using the release latch and then open the
front door. The serial number is located on the panel above the Toner Cartridge.

S
g

The Xerox Welcome Center or local representative telephone number is provided when the
machine is installed. For convenience and future reference, please record the telephone
number in the space below:

Xerox Welcome Center or local representative telephone number:

#

Xerox US Welcome Center:1-800-821-2797
Xerox Canada Welcome Center:1-800-93-XEROX (1-800-939-3769)
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Safety

BIE

Your Xerox product and supplies have been designed and tested to meet strict safety
requirements. These include Safety Agency approval, and compliance to established
environmental standards. Please read the following instructions carefully before operating the
product and refer to them as needed to ensure the continued safe operation of your product.

The safety testing and performance of this product have been verified using XEROX materials
only.

Follow all warnings and instructions marked on, or supplied with the product.
This WARNING Mark alerts users to the possibility of personal injury.

This WARNING Mark alerts users to heated surfaces.

WARNING: This product must be connected to a protective earthing circuit.

This product is equipped with a 3-wire type plug, provided with a protective earthing pin. This
plug will fit only into an earthed power outlet. This is a safety feature. To avoid risk of electric
shock, contact your electrician to replace the receptacle if you are unable to insert the plug
into the outlet. Never use an earthed adapter plug to connect the product to a power source
receptacle that lacks an earth connection terminal.

This product should be operated from the type of power source indicated on the marking
label. If you are not sure of the type of power available, consult your local power company.

Do not allow anything to rest on the power cord. Do not locate the product where persons will
step or trip on the cord.

Use of an extension cord with this product is not recommended or authorized. Users
should check building codes and insurance requirements if a properly earthed extension cord
is to be used. Ensure that the total ampere ratings of the products plugged into the extension
cord do not exceed the extension cord ampere rating. Also, ensure that the total amperage of
all products plugged into the wall outlets does not exceed the outlet rating.

Disconnect Device for this product is the power cord. To remove all electrical power to the
product, disconnect the power cord from the power receptacle.

Your equipment is equipped with an energy saving device to conserve power when the
machine is not in use. The machine may be left on continuously.

Unplug this product from the wall outlet before cleaning. Always use materials specifically
designated for this product. Use of other materials may result in poor performance and could
create a hazardous situation.
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Do not use aerosol cleaners. Follow the instructions in this User Guide for proper cleaning
methods.

Never use supplies or cleaning materials for purposes other than those for which they were
intended. Keep all supplies and materials out of reach of children.

Do not use this product near water, wet locations, or outdoors.

Do not place this product on an unstable cart, stand or table. The product may fall, causing
personal injury or serious damage to the product

Slots and Openings in the cabinet and in the back and sides of the product are provided for
ventilation. To ensure reliable operation of the product and to protect it from overheating, these
openings must not be blocked or covered. The product should never be located near or over
a radiator or heat register. This product should not be placed in a built-in installation unless
proper ventilation is provided.

Never push objects of any kind into the slots of the product as they may touch dangerous
voltage points or short out parts which could result in a fire or electric shock.

Never spill liquid of any kind on the product.

Never remove covers or guards that require a tool for removal, unless directed to do so in a
Xerox approved maintenance Kkit.

Never defeat interlock switches. Machines are designed to restrict operator access to unsafe
areas. Covers, guards and interlock switches are provided to ensure that the machine will
not operate with covers opened.

Do not put your hands into the fuser area, located just inside the exit tray area, as you may
be burned.

CAUTION: Risk of explosion if battery is replaced by an incorrect type. Dispose of
used batteries according to the instruction.

Quality Standards: The product is manufactured under a registered ISO9002 Quality system.

If you need additional safety information concerning this XEROX product or XEROX supplied
materials you may call the following number:

EUROPE +44 (0) 1707 353434
USA/CANADA 1 800 828 6571

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide Page 1-7
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Safety Standards

EUROPE

USA/CANADA

This XEROX product is certified by the following Agency using the Safety Standards listed.
Agency: TUV Rheinland
Standard: IEC60950 3rd Edition Amendments A1, A2, A3, A4 and A11.

This XEROX product is certified by the following Agency using the Safety Standards listed.
Agency: UNDERWRITERS LABORATORIES

Standard: UL 60950 3rd Edition. Certification is based on reciprocity agreements, which
include requirements for Canada.
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Regulatory Information

3

January 1, 1995:
January 1, 1996:

March 9, 1999

The CE marking applied to this product symbolizes Xerox Limited Declaration of Conformity
with the following applicable Directives of the European Union as of the dates indicated:

Council Directive 73/23/EEC amended by Council Directive 93/68/EEC, approximation of the
laws of the member states related to low voltage equipment.

Council Directive 89/336/EEC, approximation of the laws of the member states related to
electromagnetic compatibility.

Council Directive 99/5/EC, on radio equipment and telecommunications terminal equipment
and the mutual recognition of their conformity.

A full declaration, defining the relevant directives and referenced standards can be obtained
from your Xerox representative or by contacting:

Environment, Health and Safety
Xerox Limited

Bessemer Road

Welwyn Garden City
Hertfordshire

AL7 1HE

England

Telephone Number: +44 (0) 1707 353434

WARNING: This is a Class A product. In a domestic environment this product may
cause radio frequency interference, in which case the user may be required to take
adequate measures.

WARNING: This product is certified manufactured and tested in compliance with strict
safety and radio frequency interference regulations. Any unauthorized alteration
which includes the addition of new functions or the connection of external devices
may impact this certification. Please contact your local XEROX Limited representative
for a list of approved accessories.

WARNING: In order to allow this equipment to operate in proximity to Industrial,
Scientific and Medical (ISM) equipment, the external radiation from the ISM equipment
may have limited or special mitigation measures taken.

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide Page 1-9
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FCC Part 15

Reference CFR
47 Part 15
Section 15.21

A

WARNING: Shielded cables must be used with this equipment to maintain compliance
with Council Directive 89/336/EEC.

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the product is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipmentin a residential area is likely
to cause harmful interference in which case the user will be required to correct the interference
at his own expense.

Changes or modifications to this equipment not specifically approved by the XEROX
Corporation may void the user's authority to operate this equipment.

Shielded cables must be used with this equipment to maintain compliance with FCC
regulations.

Laser Safety

A

WARNING: Use of controls or adjustments or performance of procedures other than
those specified herein may result in hazardous radiation exposure.

With specific regard to lasers, the equipment complies with laser product performance
standards set by governmental, national and international agencies as a Class 1 Laser
Product. It does not emit hazardous radiation as the beam is totally enclosed during all phases
of customer operation and maintenance.
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The Electricity at Work Regulations - UK ONLY

The Electricity at Work Regulation 1989 came into force in England and Wales on 1 April 1990.
This 1989 Regulation places a duty on all employers and self-employed persons to ensure the
electrical system in their premises is constructed, maintained and operated in such a manner
as to prevent, so far as reasonably practical, danger. This includes ensuring all electrical

equipment connected to such electrical systems safely constructed, maintained and operated.

All Xerox equipment has been designed to exacting safety standards and has undergone a
variety of stringent safety tests including earth bond, insulation resistance and electrical
strength tests. Xerox Limited manufacturing plants have been awarded ISO 9000 quality
certification and are subject to regular audits by the British Standards Institution or equivalent
national standards body.

Xerox equipment which has been properly and regularly serviced and maintained should not
have to undergo additional specific safety tests pursuant to the 1989 Regulation. Customers
wishing to complete safety testing should contact Xerox Limited (see page 7-13 for details) for
advice prior to any test implementation.

XEROX equipment should, however, be properly and regularly serviced and maintained at all
times.

QUESTION: What is the Electricity at Work Regulation?

ANSWER: The Electricity at Work Regulation 1989 came into force in England and
Wales on 1 April 1990. This 1989 Regulation places a duty on all employers and self-
employed persons to ensure the electrical systems in their premises are constructed,
maintained and operated in such a manner as to prevent, so far as reasonably practicable,
danger. This includes ensuring that all electrical products connected to such electrical systems
are safely constructed, maintained and operated.

QUESTION: Does XEROX Limited comply with the Electricity at Work Regulation?

ANSWER: The regulation places a duty on all employers and self-employed persons
to ensure the electrical systems in their premises are, effectively safe.

The regulation does not impose on, amongst others, manufacturers or suppliers of such
electrical systems. However, rest assured that all XEROX equipment which XEROX Limited
and its authorized distributors supplies to customers, conforms with all the relevant safety
legislation and standards.

QUESTION: Is XEROX equipment safe?

ANSWER: All XEROX equipment supplied by XEROX Limited and their authorized
distributors conforms to all relevant safety legislation and standards.

Welcome
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QUESTION: Is the XEROX equipment in my premises safe?

ANSWER: All XEROX equipment supplied by XEROX Limited and their authorized
distributors conforms to all relevant safety legislation and standards. However, like all
electrical equipment, they have to be regularly serviced and maintained by competent
persons.

XEROX Limited Customer Service Engineers ensure XEROX equipment is serviced and
maintained to exacting XEROX safety standards. If you would like your XEROX equipment to
be serviced and maintained to such high standards, please contact your local XEROX Limited
Customer Service Organization. They will be pleased to assist you.

QUESTION: Does the XEROX equipment in my premises comply with the Electricity
at Work Regulations?

ANSWER: All employers and self-employed persons must ensure that the electrical
systems in their premises are safe. This will include ensuring XEROX equipment in such
premises is safe.

XEROX Limited’s Product Safety function has prepared a guide which contains a list of tests
which may be completed by your XEROX Limited Customer Service Organization.

THESE TESTS MUST BE CARRIED OUT ONLY BY PERSONS WHO POSSESS THE
RELEVANT SKILL, KNOWLEDGE AND EXPERIENCE TO CARRY OUT SUCH TESTS.

Please contact the XEROX Limited Customer Service Organization for further information.

THE USE OF INAPPROPRIATE TEST PROCEDURES AND TEST EQUIPMENT MAY
PROVIDE MISLEADING RESULTS AND MAY CAUSE DEATH, PERSONAL INJURY AND/
OR DAMAGE TO PROPERTY.

QUESTION: I would like to carry out my own safety tests on the XEROX equipment
in my premises.

ANSWER: You may, of course, request such tests as you deem necessary to satisfy
yourself that your XEROX equipment is safe. Your XEROX Limited Customer Support will be
pleased to advise you on such testing.

QUESTION: I require records of all tests.

ANSWER: After safety testing, your XEROX Limited Customer Service Engineer will
provide you with a certificate which details the results of all tests completed.

Page 1-12
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In the event of any defect being noted, the XEROX equipment will be switched off and
disconnected from the supply until the defect has been corrected. You will be advised of such
action to enable such defects to be corrected.

PLEASE NOTE: YOU MUST ENSURE THAT YOUR XEROX EQUIPMENT IS SAFE AT ALL
TIMES.

Please contact us if you have any queries regarding the information provided in this document.

Environment, Health and Safety
XEROX Limited

Bessemer Road

Welwyn Garden City
Hertfordshire

AL7 1HE

England

Telephone Number: +44 (0) 1707 353434
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Regulations - Europe

Certification to 1999/5/EC Radio Equipment & Telecommunications
Terminal Equipment Directive

This Xerox product has been self-certified by Xerox for pan-European single terminal
connection to the analogue public switched telephone network (PSTN) in accordance with
Directive 1999/5/EC.

The product has been designed to work with the national PSTNs and compatible PBXs of the
following countries:

Austria GermanylLuxembourg Sweden
Belgium GreeceNetherlands Switzerland
Denmark IcelandNorway United Kingdom
France IrelandPortugal Finland

Italy Spain

In the event of problems, you should contact your local Xerox representative in the first
instance.

This product has been tested to and is compliant with TBR21, a technical specification for
terminal equipment for use on analogue-switched telephone networks in the European
Economic Area.

The product may be configured to be compatible with other country networks. Please contact
your Xerox representative if it needs to be reconnected to another country's network. There
are no user-adjustable settings in the product.

NOTE: Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling it is
recommended that it is set to use DTMF signaling. DTMF signaling provides reliable and faster call set-

up.

Modification, connection to external control software or to external control apparatus not
authorized by Xerox, will invalidate its certification.
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Regulations - USA

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a
computer or other electronic device, including Fax machines, to send any message unless
such message clearly contains in a margin at the top or bottom of each transmitted page or
on the first page of the transmission, the date and time it is sent and an identification of the
business or other entity, or other individual sending the message and the telephone number
of the sending machine or such business, other entity, or individual. (The telephone number
provided may not be a 900 number or any other number for which charges exceed local or
long-distance transmission charges.)

In order to program this information into your Fax machine refer to “Machine Setup” on page
2-19 and follow the steps provided.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the rear of this equipment is a
label that contains, among other information, a product identifier in the format
US:AAAEQ##TXXXX. If requested, this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network
must comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA.
A compliant telephone cord and modular plug is provided with this product. It is designed to
be connected to a compatible modular jack that is also compliant.

& WARNING: Ask your local Telephone Company for the modular jack type installed on
your line. Connecting this machine to an unauthorized jack can damage Telephone
Company equipment. You, not Xerox, assume all responsibility and/or liability for any
damage caused by the connection of this machine to an unauthorized jack.

You may safely connect the machine to the following standard modular jack: USOC RJ-11C
using the compliant telephone line cord (with modular plugs) provided with the installation kit.
See installation instructions for details.
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The Ringer Equivalence Number (or REN) is used to determine the number of devices that

may be connected to a telephone line. Excessive RENs on a telephone line may result in the
devices not ringing in response to an incoming call. In most but not all areas, the sum of RENs
should not exceed five (5.0). To be certain of the number of devices that may be connected to
a line, as determined by the total RENs, contact the local Telephone Company. For products
approved after July 23, 2001, the REN for this product is part of the product identifier that has
the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal
point (e.g., 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

If this Xerox equipment causes harm to the telephone network, the Telephone Company will
notify you in advance that temporary discontinuance of service may be required. But if
advance notice isn't practical, the Telephone Company will notify the customer as soon as
possible. Also, you will be advised of your right to file a complaint with the FCC if you believe
it is necessary.

The Telephone Company may make changes in its facilities, equipment, operations or
procedures that could affect the operation of the equipment. If this happens the Telephone
Company will provide advance notice in order for you to make necessary modifications to
maintain uninterrupted service.

If trouble is experienced with this Xerox equipment, for repair or warranty information, please
contact the appropriate service center; details of which are displayed either on the machine or
contained within the user guide. If the equipment is causing harm to the telephone network,
the Telephone Company may request that you disconnect the equipment until the problem is
resolved.

Repairs to the machine should be made only by a Xerox representative or an authorized Xerox
service agency. This applies at any time during or after the service warranty period. If
unauthorized repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to
state tariffs. Contact the state public utility commission, public service commission or
corporation commission for information.

If your office has specially wired alarm equipment connected to the telephone line, ensure the
installation of this Xerox equipment does not disable your alarm equipment. If you have
questions about what will disable alarm equipment, consult your Telephone Company or a
qualified installer.
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Regulations - Canada

This product meets the applicable Industry Canada technical specifications.

"The Ringer Equivalence Number (REN) is an indication of the maximum number of devices
allowed to be connected to a telephone interface. The termination on an interface may consist
of any combination of devices subject only to the requirement that the sum of the RENSs of all
the devices does not exceed five.

The REN value may be found on the label located on the rear of the equipment.

Repairs to certified equipment should be made by an authorized Canadian maintenance
facility designated by the supplier. Any repairs or alterations made by the user to this
equipment, or equipment malfunctions, may give the telecommunications company cause to
request the user to disconnect the equipment.

Users should ensure for their own protection the electrical ground connections of the power
utility, telephone lines and internal metallic water pipe system, if present, are connected
together. This precaution may be particularly important in rural areas.

CAUTION: Users should not attempt to make such connections themselves, but
should contact the appropriate electric inspection authority or electrician, as
appropriate.
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Environmental Compliance

Energy Star®

XEROX Corporation designed this product to comply with the guidelines of the ENERGY
STAR® program of the Environmental Protection Agency. As an ENERGY STAR® Partner,
XEROX has determined that this product meets the ENERGY STAR® guidelines for energy

-5"/;'”’73* efficiency.
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2 Getting Started

Before you start to use your machine, there are a number of

tasks to perform. Using the instructions provided in this
chapter, unpack and setup your machine ready for use.

Installing Drum and Toner Cartridges

YV ¥V ¥V V¥V ¥V V VY V VY

Unpacking . . ......... ... ...
Machine Overview. . . ......................
Making Connections .. ....................
Powering On the Machine . . ................
LoadingPaper............ ... ... ... .. ....
Help List. .. ... ... .. L
Machine Setup. . .. ......... ... ... ... . ...
Machine Setup. . .. ......... ... ... ... .. ...
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Getting Started

Unpacking

1

2,

® Toscanorcopya
document, the
switch must be in
the unlock
position. If the
machine is not
being used for a
long period of
time, or being
moved, push the
switch to the lock

position (1¢1)

©

> Pull open the paper tray and

» Remove the shipping tape from
the front, back and sides of the
machine.

> Remove the label completely
from the scanner module by
pulling it straight out, away from
the unit.

The scan unlock switch Scanner
automatically moves to the unlock ~ Module

position ( ).

remove the packing material from
the tray.

Page 2-2
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4,

® The appearance > Ensure the following components
of the power cord

andthe telephone are available:
line cord may

vary according to

Country.

S

AC Power Cord

Starter Toner Cartridge

WorkCentre M20 and M20i only:

Telephone Line Cord

Software

User
Documentation

Drum Cartridge

SS

USB Cable

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide
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Getting Started

Models and Options
CopyCentre C20 WorkCentre M20 WorkCentre M20i

= = =
Document Feeder Standard Standard Standard
Paper Tray 1 & Bypass Standard Standard Standard
Tray
Digital Copying Standard Standard Standard
Direct Printing - Standard Standard
Network Printing - Option Standard
Direct Scanning - Standard Standard
Fax - - Standard
E-mail - Option Standard
Paper Tray 2 Option Option Option
Cabinet and Stand Option Option Option
Foreign Interface Option Option Option
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Component Location

Front View:

Document
Guides
Document Feeder Document Input
Tray
Document .
Control Panel Output Tray Paper Guides

Side Cover

Scanner

Module Paper

Tray 1 Release lever

Front Cover

Paper Tray 2

>

‘—\ﬁ/

NOTE: The components on each model vary, this picture represents the WorkCentre M20i with the
optional Paper Tray 2.
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Getting Started

Rear View:

Document Feeder
Document Feeder

Connector

Telephone Connections P, < o Document Glass

% Paper Tray

Paper Exit Extension

AC Power Cord
Connector

Power Switch

Parallel Connector

USB Connector

NOTE: The components on each model vary, this picture represents the WorkCentre M20i, standard
configuration.

Page 2-6
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Control Panel Overview

Navigation keys Clear/ Clear All (AC)
Menu/Exit Status keys
Copy, Fax and Email keys Display Interrupt
| | |
o hlal \ A IE oief
- ' ren P , e "“""’“.& \.1_/ (.2) \.a./ Gl
I S D D M e D
CEYe YL LBULEY D G @
HwewsnswEun L) PN
CODEDHEADNEFEDEGE T -
EN :
Alphabet Feature Fax Numeric Start
Keyboard keys (1-7) Paper Supply ~ Functions  Keypad Stop
ITEM DESCRIPTION
Alphabet Keyboard |Use to enter alpha and symbol characters for the E-mail and Fax functions.
© Lighten/Darken |Use to adjust the contrast level to improve output quality.
® Reduce/Enlarge |Use to adjust copy size from 25% to 400% when using the Document
Glass, and 25% to 100% using the Document Feeder.
© 2 Sided Use to scan 2 Sided originals and produce 2 Sided output.
©® Collated Use to produce collated output.
© Original Type Used to select the type of original being scanned.
@ Color Original Use this option when scanning a color original.
@ Resolution Use to adjust the scan resolution.
Copy Select to activate the Copy mode. The Copy key illuminates when selected.
Fax Select to activate the Fax mode. The Fax key illuminates when selected.
(WorkCentre M20i only.)
E-mail Select to activate the E-mail mode. The E-mail key illuminates when
selected.
Menu/Exit Use to access the menu functions and also to move up through the menu
levels.
Enter Use to confirm the selection on the display.
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Getting Started

Navigation Keys

Use to scroll through the menu items and the options available for each

D menu item.
©©©
Paper Supply Use to select a paper type and source. Each press of the Paper Supply key
changes the selection. The Status Map indicates the selected tray.
NOTE: Paper Tray 2 is available as an option.
Status Map The Status Map identifies which paper tray is selected, when a paper tray is
Document

Feed|er Error Bypass
Paper \ ‘
Jam

1
"
Tray 2

!
l
Tray 1

empty and when an error occurs.

The Status Map has a light for each paper tray. A paper tray can be
selected using the Paper Supply key. Each time the key is pressed, a
different tray is selected and a green light displays to indicate the selected
tray. When two tray lights display together, the Auto Tray Switching feature
is active. This enables the machine to switch to a different tray if the current
tray runs out of paper.

If a paper tray is empty, the light will flash and if enabled, an error tone will
sound.

If an error occurs, a red light displays indicating the location of the error,
and a message appears on the display providing further information.

@ For a detailed description of the error messages, refer to “LCD Error
Messages” on page 11-11.

Display

Displays the current status and the menu prompts and selections.

Job Status

Use to view the current job status, add pages to jobs in memory and to
delete jobs.

Machine Status

Use to access setup menus and customise the machine.

Manual Group

Use to manually enter multiple destinations for a fax job. (WorkCentre M20i
only.)

Manual Dial Use to dial a fax number manually. (WorkCentre M20i only.)
Speed Dial Use to dial fax numbers and send faxes by entering a Speed Dial number
which has been set up previously and stored in the machine’s Dial
Directory. (WorkCentre M20i only.)
Pause/Redial Use to redial the last phone number called or to add a pause when storing a
number in the dial directory. (WorkCentre M20i only.)
Numeric Keypad Use to enter alphanumeric characters.
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Interrupt

&

Use to interrupt the current copy job to run a more urgent job.

confirmation.

Start Use to activate a job.
Stop Use to stop an operation at any time.
Clear/Clear All (AC) |Press once to clear a current entry e.g. an incorrect number or character

entry. Press twice to clear all programmed settings, the display requests

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide
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Installing Drum and Toner Cartridges

Getting Started

o > Pull the release latch to open the
side cover.

CAUTION: Ensure the side cover
is always open before opening
the front cover.

9 > Open the front cover.

9 > If the cartridge locking lever is in

the lower position, turn the lever \“tj/ . & :
£ ISy,

upward until it locks into place.
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® Xerox
has included a
Starter Toner
Cartridge.
Purchased
replacement
toner cartridges
will yield
approximately
two times the
number of copies.

6

7

® Whenthe drumor
toner cartridge
need to be
replaced a
message
displays.

> Remove the drum cartridge from
its bag and slide it into the
machine firmly until it locks into
place.

CAUTION: Do not expose the
green drum to light for an
extended period. Never expose
the drum to direct sunlight or
touch the drum surface. Damage

or poor image quality may result.

» Remove the starter toner
cartridge from its bag.

> Gently shake the cartridge to
loosen the toner.

Shaking the cartridge will ensure
maximum copies per cartridge.

> Slide the toner cartridge into the
machine, aligning the cartridge to
the left of the slot, until it locks
into place.

> Turn the toner locking lever
downwards until it locks in place.

» Close the front cover and the side
cover.

The product returns to Standby
mode.

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide

Page 2-11

Getting Started



Getting Started

Making Connections

0 Document Feeder

» Connect the Document Feeder
cord to the port shown and fasten
the side screws.

@ Telephone Line (WorkCentre M20i only)

® You should use
the telephone line
cord which is
supplied with your
machine. If you
are replacing it
with another
vendor’s, it
should be AWG
#26 or larger tele-
communication
line cord.

> If required, plug the cord of your

> Connect the supplied telephone
line to the LINE jack and the other
end to the wall jack.

If you want to use your machine
for receiving both faxes and voice
calls, you will need to connect a
telephone and/or answering
machine.

extension phone into the EXT
jack.

Page 2-12
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USB or Parallel Port Cable
(WorkCentre M20 and M20i only)

CAUTION: Shut down the
computer before connecting the
cable.

» Connect the USB Cable which
came with your machine.

OR

> If you want to use a parallel print
cable, only use an IEEE-1284
compliant cable and connect it to
the parallel connector on your
machine.

@ Only connect one of the above cables. If you are using a USB cable, you must be running
Windows 98, Me, 2000 or XP. When using the USB connection, your machine provides two USB
modes; Fast and Slow. Fast is the default mode. Some PC User’s may experience poor
functionality in the default mode. If this occurs, select the Slow mode. For information about
changing the USB mode, refer to “Machine Setup” on page 2-19.
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Getting Started

Powering On the Machine

1

2

» Connect the AC Power Cord to
the machine and a power outlet.

The power cord must be plugged
into a grounded power socket.

> Press the ON/OFF switch to the
ON (1) position.

The machine displays ‘'Warming
Up Please Wait...".

Page 2-14

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide



Loading Paper

O

® An additional
Paper Tray is
available as an
option. The
instructions for
loading both
paper trays are
the same.

> Pull open the Paper Tray.

9 > Push down on the pressure plate
until it locks into position.

9 > Adjust the rear paper guide to the
required paper length.

It is preset to A4 or Letter size
depending on country.

» To load another size, lift the rear
guide out of the current position
and into the required position.

@  The Paper Trays can hold a
maximum of 550 sheets of 80 g/m2
(20 Ib) plain paper. You can use
A4, Letter or Legal size paper only.

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide
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Getting Started

® Ifyou experience  » Fan the paper and insert it into
problems with

paper feed, turn the tray.

the paper around .

and i the problem If Io.adlr?g Letterhead, ensure the
continues, use design is face-up and the top

the Bypass Tray. edge of the sheet is placed at the

4,

right side.

@ > Ensure that the paper is

positioned under the snubbers.

Corner
snubbers

» Do not fill above the Maximum Fill
Line.

Max Fill
Line

Page 2-16
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o When printin;

from your PC, > Position the side guide by
ensure you select

squeezing the lever and sliding it
the Paper Source .
and the correct toward the stack of paper, until it
paper size from gently touches the side of the
your software stack.

application.
Do not allow the guide to press
against the edge of the paper
tightly.

> Close the Paper Tray.

@ Refer to “Machine Setup” starting on page 2-19 to set the correct size for the Paper Tray.

For more detailed information about Paper Supply, refer to the Chapter “Paper and Other Media”
starting on page 4-1.
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Help List

The Help List contains information about the features and settings available on your machine.
It is helpful to print the list to use as a reference tool when performing Machine Setup tasks.

Use the following instructions to print the Help List.

o > Press the [Menu/Exit] key.

Menu/Exit Enter

9 > Using the Navigation Keys select
the [Help List] and press [Enter].

Help List Printing... displays.
- Help List
The Help List is printed. c-b 18

9 > Press [Menu/Exit] to exit each menu level and return to standby mode.

Page 2-18
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Machine Setup

Use the following instructions to customize your machine to meet your individual

requirements.

0 > Press the [Machine Status] key.

@ > Using the Navigation Keys select
[Machine Setup] and press

[Enter].

@ > Using the Navigation Keys select
the required setup option and
press [Enter].

> Using the “Machine Setup
Options:” starting on page 2-20
customize the settings to meet
your requirements.

> Press [Enter] to save your
selections.

.

o t\*.!ul

0 ¢

| sbn A moin
D) B

Enter Machine

Status

- Machine Setup
Fax Setup

Machine Setup
[Tray 1 Size]

0 > Press [Menu/Exit] to exit each menu level and return to standby mode.
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Getting Started

Machine Setup Options:

OPTION

SETTINGS

DESCRIPTION

Tray 1 Size

LTR/A4/LGL /Folio

Use to set the default paper size
for Tray 1. Paper Size options are
Letter, A4, Legal (216 x 356 mm /
8.5 x 14 inch) or Folio.

Tray 2 Size

LTR/A4/LGL /Folio

Use to set the default paper size
for Tray 2. Paper Size options are
Letter, A4, Legal (216 x 356 mm /
8.5 x 14 inch) or Folio.

Bypass Size

LTR/A4/LGL /Folio/
A5 / Statement

Use to set the default paper size
for the Bypass tray. Paper Size
options are Letter, A4, Legal (216 x
356 mm / 8.5 x 14 inch), Folio, A5
or Statement.

® If feeding media smaller than A4/
Letter through the bypass tray,
the setting can remain set at A4,
Letter or Legal size.
When copying onto a paper size
smaller than A4/Letter, the
printed image may be offset and
not reproduce correctly, even
when Auto Fit is selected.

Power Save

On

Ooff

Use to enable the Power Save
feature. If Onis selected, set the
period of time the machine waits
before Power Save is activated.
Choose between 5, 10, 15, 30 or
45 minutes.

Time Out

15/30/60/180
Seconds

OFF

Sets the number of seconds the
machine remains idle before
switching to Power Save mode.
The period set here starts after the

last print job.
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OPTION SETTINGS DESCRIPTION
Stamp RX Name ON Set to ON to enable the page
number and date and time of
OFF . .
reception to be printed on each
page of each received
transmission.
Alarm Sound ON Set to ON to enable an alarm
sound when an error occurs or a
OFF -
fax communication ends.
Key Sound ON Set to ON to enable a key sound
when any key is pressed.
OFF e e
Speaker Control ON The speaker can be set to ON,
OFF OFF or COM. With this option set
to COM, the speaker is on until the
com remote machine answers.

Language

English, French,
Spanish, Portuguese,
German, Italian, Dutch,
Danish, Swedish,
Finnish, Norwegian,
Swedish, Russian

The LCD displays in the language
selected.

Localization

Inch

MM

FAST is the default mode. Some
PC users may experience poor
USB implementation in the default
mode. If this occurs, select the
SLOW mode in order to achieve
successful results.

Select Country

Setting the COUNTRY option sets
the correct fax communication
settings for the PSTN system
pertaining to each country.

NOTE: The Country option is not
applicable to North America and
Canada.
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Getting Started

® When receiving a
document as long as or
longer than the paper in
the machine, the fax
machine can be set to
discard any excess at the
bottom of the page.

OPTION SETTINGS DESCRIPTION

USB Mode Fast Use to set the USB speed. Fast is

the default mode. Some PC users
Slow .

may experience poor USB
implementation in the default
mode. If this occurs, select the
SLOW mode in order to achieve
successful results.

Device Name Fax Use to enter the fax number and
name of the machine.

ID

Date & Time Enter the current date and time
using the numeric keypad. Use
Clock Mode to set whether the
machine uses a 12 or 24 hour
clock.

Clock Mode 12 hour The machine can be configured to
display time using either a 12-hour

24 hour or 24-hour format.

Toner Save ON Use to set the machine to use less

toner and print lower quality output.
OFF p q y outp
Discard Size [00 - 30] If the Fax Setup option Auto

Reduction is turned OFF or fails,
and the received document is as
long or longer than the paper
selected, the machine will discard
any excess image at the bottom of
the page.

If the received page is outside the
discard margin set, it will print on
two sheets of paper at the actual
size.

Margins can be set between 0 -
30mm (1.2")
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Installing Software

There are four drivers provided:
- PCL5
- PostScript
- Twain
- ControlCentre

The installation procedure is the same for all of them. You can install all of the drivers at the
same time or as many as you require.

@’ These instructions are for installing direct printing and scanning via the parallel or USB. For
Xerox WorkCentre M20i network connections, it is recommended that you contact your System
Administrator or refer to the System Administration Guide.

The Xerox WorkCentre M20 and M20i can be connected directly to the USB or Parallel Port
of a host Workstation. A document file can be sent or received from the host Workstation via
the appropriate port to the Xerox WorkCentre M20 or M20i.

Prior to installing the drivers, ensure the USB or Parallel Port connection has been made
between the Xerox WorkCentre M20 or M20i and the Workstation.

@ For USB or Parallel Port connection instructions, refer to “Making Connections” starting on page
2-12.

There are three stages required to installing the machine on a port on a local workstation:

> Install the driver.

This requires the appropriate printer driver to be installed on the workstation.

> Workstation Setup

This requires the workstation to be configured to print to the WorkCentre M20i.

» Test Print or Scan

A print job should be submitted to ensure the WorkCentre M20i has been installed and
configured correctly.
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Driver Installation
Before direct printing, direct scanning or using ControlCentre through the Parallel Port or the
USB port, you will need to install a driver.
The procedure will install the driver and configure it for the local port.

To install the driver on the workstation.

0 > Insert the Driver CD into the CD drive.

Within a few seconds, the CD should start automatically and present you with the opening
screen. If this does not happen, go to the Start menu, select [Run] and browse to the CD
drive. Select [Setup] and click [OK]. Click [OK] to start the installation procedure.

Xerox WorkCentre M20 Series Setup x|

[English =

THE DOCUMENT COMPANY

9 > Select the language for the installation and select [Continue].

The driver screen is displayed.

[Xetox WorkCentre M20 Series Setup x]

Software companents to install:

% PC Print [PCL 6) [2.36 MB)
¥ PC Print (Post Scripy (217 MB)
THE DOCUMENT COMPANY B PG Sean [2.58 ME)
¥ ControlCentre {1.15 MB)

If you wish to install a particular
software component, check the box
to the left of its name.

Continue

@ > Check the boxes for the drivers required, PostScript, PCL, PC Scan and ControlCentre.
> Select [Continue].

@ You can choose to install as many drivers as you require by checking the appropriate boxes.
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The selection will be confirmed.

[Xerox WorkCentre M20 Series Setup

You have chosen to install:

BC Print (PCL 6]
PC Print (Post Scripy
PC Scan
ControlCentre

THE DOCUMENT COMPANY

Click the *Back’ button to change
the software components you have
selected to install.

< Back Continue

> Select [Continue] to confirm your choice and install the driver.

The installation will continue by transferring a number of files.

@ If you chose to install multiple drivers, the installation process will be repeated for each driver.

> Select [Finish] to complete the installation.

> Switch the printer Off and then On.

@ For instructions for powering the machine on and off, refer to “Powering On the Machine”
starting on page 2-14.

» Reboot the Workstation.

@O O

Windows will automatically detect new hardware and install the appropriate driver.

Follow the instructions for “Workstation Setup” starting on page 2-26 to continue the
installation.
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Workstation Setup

You will need to configure the printer drivers.

0 > At the Workstation, select [Printers and Faxes] from the Control Panel option.

Getting Started

@ The location of this window will vary according to the operating system: from the Start>Settings
menu or directly from the Start menu.

The Printers and Faxes window will be displayed.

Printers o]
Fle Edt View Go Favortes Help ‘

« % W B = ¥ 2| =
BACK Feiizie) Up Map Drive Disconnect Cut Copy Paste Undo
Addiess [3] Pinters H
= =
&
Add Printer Heron WT

Printers ensed

Xerox WC MZ0 Series PS

Documents: 0

@ This window will have a different appearance according to the operating system of the
workstation. The window displayed is for a Windows XP operating system.

@ > Click on the Printer and select [Properties] from the File menu or the right mouse menu.
A properties window will be displayed.

& Xerox WC M20 Series PS Properties (B3]

e

=2

Location ‘

Comment:

Model: eronWC M20 Series PS

Features

Color: o Faper avalatle:
Double-sided: Yes Letter
Staple: o

Speed: 20 ppm

Maximum resolution: 1200 dpi

[Printing Preferences...| [ Pint Test Page

0
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@ This window will have a different appearance according to the operating system of the
workstation and the type of driver installed. The window displayed is for a Windows XP operating

system.
9 > Click on the [Ports] tab.
The Ports tab will be displayed.
& Xerox WC M20 Series PS Properties |E|E|
General | Sharing| Ports | Advanced | Secuity | Device Settings
IR

&ﬁ Reron W M20 Series PS

PBrint to the fallawing port(s). Decuments wil prink to the first free
checked port

Part Description Printer -~
Piinter Port B

O LPT2: Piinter Port

O LPT3: Printer Port A

O coM1: Serial Port
O CoM2: Serial Port
O COM3: Gerial Port
O CcOM4: Serial Port

[£3

[ addPot. | [ DeetePot | [ ConfigwePat..

Enable bidiectional support
[ Enable printer pogling

oy

9 > Check the box appropriate to the connection.

For a parallel connection, check LPT1, LPT2 or LPT3 depending on the configuration of
the workstation. This is usually LPT1.

For a USB connection, check the USB box.

@ > Click [OK].
Follow the instructions for “Test Print or Scan” starting on page 2-28 to continue the
installation.
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Test Print or Scan

OO0 dO

To ensure the Xerox WorkCentre M20 or M20i has been installed correctly a test print or scan
should be submitted from the Workstation.

Test Print

Perform the following steps:

> Open a document on the Workstation.

> Select the Xerox WC M20 Series as the printer to which the document will be sent.

> Print the selected document on the device and verify that it prints correctly.

The installation process is now complete.

Test Scan
> Open the Twain compliant application being used to scan documents.

> Follow the instructions provided in “Scan” starting on page 8-1 to scan a document and
verify that it scans correctly.

The installation process is now complete.
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3 Copy

Digital copying is available as standard on the Xerox

CopyCentre C20, WorkCentre M20 and WorkCentre M20i.

YV V YV V V

Copying Procedure . .......................
Basic Copy Features. .. ....................
Special Copy Features ....................
Using Interrupt. . . ... ... ... ... ... .....

Compatible Features . . .. ..................
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§ Copying Procedure

0 Select Copy Mode

9 Select the Paper Supply

® forinstructions
on loading media,
refer to “Loading
Paper” on page 4-
2.

For full media
specifications
refer to “Media
Specifications”on
page 12-7.

> Ensure Ready to Copy displays.

> If necessary, press the [Copy]
key to change to Copy mode.

The Copy key remains
illuminated when selected.

> To select a paper tray, press the
[Paper Supply] key until the
required tray is lit on the Status
Map.

Tray 1 and the Bypass Tray are
available as standard, Tray 2 is
optional.

If two tray lights display together,
the Auto Tray Switching feature is
active. When one tray runs out of
paper, the machine will switch to

the other selected tray.

Ready To Copy
1Q0% 0Q1

Current Reduction /
Enlarge Setting

Number of Copies

Copy Key

—
R gE—

Status Map

Paper Supply
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@’ When copying onto a paper size smaller than A4/Letter, the printed image may be offset and not
reproduce correctly, even when Auto Fit is selected.

> If the Bypass Tray is selected the
Paper Type option displays. Use
the Navigation Keys to select the
Paper Type being loaded and

JETE

press [Enter]. (O
f |°["' i
If using the Bypass, remember to 20 o) (o

load the required stock.

6 Load the Originals

Document Feeder:

> Remove all staples and paper
clips prior to loading.

> Adjust the sliding document .
Document é/é

guides to the size required.
Guides

> Insert the originals neatly into the
Document Feeder, face up.

The first page should be on top
with the headings towards the
back or left of the machine.

> Align the stack with the left and
rear edges of the tray. Adjust the
guides to just touch the edges of
the originals.

Copy

®  Up to 50 sheets of 80 g/m2 (20Ib bond) paper can be loaded. Weight ranges from 45 - 105 g/m2
(12.5 - 28Ib). Sizes range from B5 to Legal (7” x 10” to 8.5” x 14” ). Refer to “Scanner and Copier
Specifications” on page 12-5 for full Document Feeder specifications.
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Copy

® When using the

Document Glass:

> Raise the Document Feeder and
position the original face down on
the Document Glass.

Document Glass,
ensure there are
no documents in
the Document
Feeder. Align with the registration arrow in
the rear left corner.

Leaving the
Document
Feeder open
while scanning
will affect the
image quality and
toner
consumption.

» Lower the Document Feeder.

a Select the Copy Features

Only those
features relevant
to the machine
configuration will
be available.

> Press the Copy feature key
required on the Control Panel.

Basic features available for Copy
jobs are Lighten/Darken, Reduce/
Enlarge, 2 Sided, Collated,
Original Type and Color Original.

(& For information about all the
available Copy features, refer to
“Basic Copy Features” on page
3-6, and “Special Copy
Features” on page 3-10.

> Using the Navigation Keys, select
the setting required for the
feature and press [Enter].

Lighten/Darken
Original Type
Reduce/
Enlarge
2 Sided
Collated

Color Original

Page 3-4
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@ Enter the Quantity

® The maximum > Use the Numeric Keypad to enter

gggy quantity is the number of copies required.

> If necessary, press [Clear/Clear
All] to clear the current quantity
and enter a new quantity.

Numeric Keypad
Clear/Clear All

e Youcancancela Press Start
copy job while itis

copying by > Press [Start] to begin the copy
pressing the .
[Stop] key twice. job.

» If Collated is On, when the
document is fed from the
Document Glass, the display
shows [Scan Another?].

Navigation Keys Start

> To scan another original, load the
next original and using the
Navigation Keys select [Yes] and
press [Enter].

Continue the procedure until all
the originals have been scanned.

> Select [No] when all the originals
have been scanned, and press
[Enter].

Printing commences and copies
are delivered to the Output Tray.
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2 Basic Copy Features

There are seven basic Copy features available. These features can be selected using the
feature keys located on the Control Panel.

Lighten/Darken

Reduce/
Enlarge

2 Sided
Collated

Color Original

Feature Description

Original Type

containing faint
or dark images.

\4

FEATURE OPTIONS INSTRUCTIONS
Lighten/Darken |5 Contrast Settings > Press [Copy].
e Usetoadjustthe > Press [Lighten/Darken].
contrast for a X L.
document » Using the Navigation Keys select a contrast

setting.

Each time the key is pressed the selection block
on the display moves to the left or right. As the
selection block moves to the right the contrast
becomes darker.

Press [Enter] to save the selection.

Reduce/Enlarge

® Use to reduce or
enlarge an
image from 25%
to 400%,
depending on
the input area
used.

25 - 400% |Reduce/Enlarge from 25 -
400% using the
Document Glass, and
from 25 - 100% using the
Document Feeder.

Press [Copy].
Press [Reduce/Enlarge].

Enter the percentage required using the Numeric
Keypad. The selected number appears on the
display.

> Press [Enter] to save the selection.

Page 3-6
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printed on 1 side only and
2 Sided copies, with the
conventional "head to

head" layout are required.

Short

Use when originals are
printed on 1 side only and
2 Sided copies, with the
"head to toe" layout are
required.

Use when originals are
printed on both sides, with
the conventional "head to
head" layout, and 1 sided
copies required.

Clone |Use to print multiple > Press [Copy].
images on a single sheet
> .
S seper e FLTaET aF Press [Reduce/Enlarge]
images produced is > Using the Navigation Keys, select [Clone] and
determined automatically press [Enter].
Pased oln the original Clone appears on the display.
image size.
® Only available using the
Document Glass, ensure
the Document Feeder is
empty.
Auto Fit |Use to reduce or enlarge |> Press [Copy].
tt.1e image to .ﬂt the paper > Press [Reduce/Enlarge].
size automatically.
> Using the Navigation Keys, select [Auto Fit] and
® Only available using the press [Enter].
Document Glass, ensure
the Document Feeder is Auto Fit appears on the display.
empty.
2 Sided 1-1 Sided |Use when originals are > Press [Copy].
printed on 1 side and 1- .
> .
® sjf)f 2“;@; ° ddgoCSy sided copies are required. Press [2 Sided]
output from 1 or [ 4 5 o - » Use the Navigation Keys to select the option
2 sided originals. 1-2 Sided |Use when originals are required and press [Enter] to save the selection.

> If necessary, use the [Scan Side 2] option to scan
side 2. Position side 2 on the Document Glass
and select [Yes] then [Enter] to scan side 2.

Continue the procedure until all the originals have
been scanned.

> Select [No] when all the originals have been
scanned, and press [Enter].
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Copy

2-1 Sided
Short

Use when originals are
printed on both sides in
the "head to toe" layout,
and 1 sided copies are
required.

® Use when
scanning a color
original.

originals.

2-2 Sided |Use for originals that are
printed on 2 sides and 2
Sided copies are
required.
Collated On Use to produce collated |> Press [Copy].
output e.g. 2 copies of a 3
° g(f/fag (fg ‘;‘Z)uce page job will print one > Press [Collated].
sefs. Y complete document, > Use the Navigation Keys to select [On] and press
followed by the second [Enter].
complete document.
Original Type Text Use for documents > Press [Copy].
containing mostly text. -
e Useto selectthe 9 y > Press [Original Typel].
t f i i
Jgfug,em being Mixed U?'e 20; docurgents Vt:_'th > Use the Navigation Keys to select the option
scanned. mixed text and graphics. required and press [Enter].
Photo |Use for photographs.
Color Original On Use when scanning color |> Press [Copy].

> Press [Color Original].

> Use the Navigation Keys to select [On] and press
[Enter].
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Paper Supply

® Useto selectthe
paper source.

Status The Status Map identifies |> Press [Copy].
W ) .
ap which paper tray is > To select a paper tray, press the [Paper Supply]
selected, when a paper . . -
. key until the required tray is lit on the Status Map.
tray is empty and when an
error occurs. The Status Map identifies which paper tray is
Document selected, when a paper tray is empty and when an
Feeder Elm" Bypass error occurs. The Status Map has a light for each
Paper % || papertray
Jam Each time the [Paper Supply] key is pressed, a
= different tray is selected and a green light displays
r { T to indicate the selected tray. When two tray lights
ay 1 Tray 2 i i
display together, the Auto Tray Switching feature
is active. This enables the machine to switch to a
different tray if the current tray runs out of paper.
If a paper tray is empty, the light will flash and if
enabled, an error tone will sound.
Bypass |Use to notify the machine |> If the Bypass Tray is selected the Paper Type

the type of paper loaded
in the Bypass Tray.

option displays. Use the Navigation Keys to
select the Paper Type being loaded and press
[Enter].

If using the Bypass, remember to load the
required stock.
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§ Special Copy Features

The special Copy features available can be accessed by pressing the Menu/Exit key and then

selecting Copy Features on the display.

Menu/Exit fE= ¢ Enter
‘:"" A i
oo
Navigation Keys
Feature Description
FEATURE OPTIONS TO SELECT
ID Card Copy - Press [Menu/Exit].

® Useto copy both
sides of an ID
document e.g. a
drivers license,
onto one side of
paper.

Using the Navigation Keys select [Copy Features]
and press [Enter].

Use the Navigation Keys to select [ID Card Copy]
and press [Enter].

[Press Start S.1] displays. Load Side 1 of the
original on the Document Glass and press [Start].

Repeat for Side 2 when [Press Start S.2] displays.

The machine prints both sides of the ID document
on one side of paper.

Page 3-10
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Edge Erase Off Use to de-activate the > Press [Menu/Exit].

e Use to ‘clean up’ feature. > Using the Navigation Keys select [Copy Features]

the edges of an | Small Orig |Use to erase 6 mm (0.25") | and press [Enter].

original e.qg. if it
is frayed or has Edges |from the edge of the

hole punch or document.
staple marks.

> Use the Navigation Keys to select [Edge Erase]
and press [Enter].

Binder |Use to erase 24 mm (1.0")
Holes |from the left edge of the
document.

> Select the required Edge Erase option and press
[Enter] to save the selection.

Book |Use toerase 6 mm (0.25")
Center & |from the left and right
Edges |edge of the document.

Border |Use to create a border
Surround |around all edges of the

Copy

document.
Margin Shift Off Use to de-activate the > Press [Menu/Exit].
fi . . L
e Use fo create a eature » Using the Navigation Keys select [Copy Features]
binding edge for | Auto  |Use to center the image and press [Enter].

the document.
Center  on the paper. > Use the Navigation Keys to select [Margin Shift]

Left  |Use to enter a shift and press [Enter].
Margin  amount for the left margin. |,

Select the required Margin Shift option and press

Right |Use to enter a shift [Enter].
Margin amou.nt for the right > If required, enter a shift amount using the Numeric
margin. Keypad and press [Enter].

Top Use to enter a shift
Margin |amount for the top
margin.

Bottom |Use to enter a shift
Margin |amount for the bottom
margin.
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Book Copy Off Use to de-activate the > Use the Document Glass when copying bound
feature. documents.
® Use when
ZOPYI'"Q bt0U7fd Left Page |Use to scan and copy the | > Press [Menu/Exit].
ocuments.
the document is sif]gizfe (07 el > Using the Navigation Keys select [Copy Features]
too thick, lift the document. and press [Enter].
cover until its -
Z‘Ianghst thhe ';’ght QSE to scanfang cop(:/ the |, Use the Navigation Keys to select [Book Copy]
stopperandthen age right page of a boun and press [Enter].
close the cover. document. i X
Select the required Book Copy option and press
Both  |Use to scan and copy [Enter].
Pages |both pages of a bound
document.
Auto Suppress On Use to activate the 'Auto Press [Menu/Exit].
’ f . . L
e Use when Suppress’ feature Using the Navigation Keys select [Copy Features]
copyingoriginals Off Use to de-activate the and press [Enter].
which require feature
the background ) Use the Navigation Keys to select [Auto
removing. Suppress] and press [Enter].
Select [On] and press [Enter].
Covers Off Use to de-activate the Press [Menu/Exit].
f . . L
e Useto eature Using the Navigation Keys select [Copy Features]
aZZ)maticallty Front |Use to add a blank or and press [Enter].
a covers 1o .
your copied set zggt:: DT ERYEL B il Use the Navigation Keys to select [Covers] and
using stock les.
taken from press [Enter].
AT ) Back |Use to add a blank or Select the required Covers option and press
printed back cover to the [Enter].
copies.
Select the Paper Tray containing the covers stock
Front & |Use to add a blank or and press [Enter].
Back |printed front and back

cover to the copies.

Select [Blank] or [Printed] depending on your
requirement, and press [Enter].
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from 4 originals on to one
page.

Transparencies Off Use to de-activate the > Press [Menu/Exit].
e Use to create a feature. > Using the Navigation Keys select [Copy Features]
ff”g/e set of Bypass |Use to create a single set | and press [Enter].
ransparencies H :
with blank or gr trinspargr:c;ezvv.lctjh a8 | Usethe Navigation Keys to select
printed ank or printed diviaer [Transparencies] and press [Enter].
separators. between each
transparency. > Use the Navigation Keys to select [Bypass] and
press [Enter].
> Use the Navigation Keys to select [Off], [Printed]
or [Blank] for the separators and press [Enter].
> Select a Paper Tray for the separators and press
[Enter].
Create Booklet On Use to activate the > Press [Menu/Exit].
e Use to copy a Create Booklet feature. > Using the Navigation Keys select [Copy Features]
documentas a2 Off Use to de-activate the and press [Enter].
Sided job and T
arrange the : > Use the Navigation Keys to select [Create
pages to Booklet] and press [Enter].
produce a
booklet when
folded. > Select [On] and press [Enter].
N Up Off Use to de-activate the > Press [Menu/Exit].
e Use to print 2 or feature. > Using the Navigation Keys to select [Copy
4 original 2Up Use to print the images Features] and press [Enter].
images reduced s
on to one page. from 2 originals on to one > Use the Navigation Keys to select [N Up] and
page.
press [Enter].
4 Up Use to print the images |,

Select the required N Up option and press [Enter].

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide
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g Using Interrupt

The Interrupt button is used to temporarily pause the job which is currently being copied in
order to run a more urgent job. This feature is useful if the machine is printing a large job as it
still provides access to Copy mode for running small, quick jobs.

0 Select Copy Mode

> Interrupt is only available in Copy Copy Key
mode. Press the [Copy] key to
activate Copy mode.

@ Select Interrupt

> To interrupt the current Copy job,
press the [Interrupt] key.

» The machine activates the ‘ i \: g;) 7” -
Interrupt feature and the Interrupt (@ ﬂ ? S0
key remains illuminated. I ° ) @ w o

The job pauses after the current
sheet has been printed or the
current original has been
scanned.

Interrupt

(& Ifthe current job cannot be
interrupted, a message displays.
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6 Load the Originals

> Remove all staples and paper
clips prior to loading.

> Load the originals for the Interrupt
job into the Document Feeder or
load a single original on the
Document Glass.

@’ For full instructions on loading
originals refer to “Load the
Originals” starting on page 3-3

@ Select the Interrupt Job Features

® Only those
features relevant > Basic features available for Copy

fo the machine jobs are Lighten/Darken, Reduce/

configuration will .

be available. Enlarge, 2 Sided, Collated,
Original Type and Color Original.

@ For information about all the
available Copy features, refer to
“Basic Copy Features” on page
3-6, and “Special Copy
Features” on page 3-10.

> Press the feature key required
and using the Navigation Keys,
select the setting required for the
feature. Press [Enter].

Lighten/Darken

Original Type

Reduce/
Enlarge

2 Sided
Collated

Color Original

Copy
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Copy

6 Enter the Quantity
® The maximum > Use the Numeric Keypad to enter
gggy quantity is the number of copies required.

Numeric Keypad

Press Start

> Press [Start] to begin the Inferrupt
job.

> If using the Document Glass and
[Scan Another?] displays, select
[Yes] to scan another original, or
[No] if all originals have been
scanned; press [Enter].

The Interrupt job is printed. Navigation Keys Start
If another urgent job is required
repeat the procedure.
Resume Current Job
> To resume the interrupted job,
Interrupt

press the [Interrupt] button.

The Interrupt feature is
deactivated.

> Ifrequired, reorder and reload the
originals as instructed and press
[Start].

The interrupted job resumes.
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Compatible Features

The following table indicates which features are compatible with other features. It also shows
which input area can be used for a feature e.g. the Document Feeder or Document Glass.

Copy

COPY Document ID Copy| Book | Create | N Up Edge Erase Margin Auto Covers Trans-
Feeder or Glass Co Booklet Shift | Suppress arencies
FEATURE Py PP P
ID Copy Glass
Book Copy Glass X
Create Booklet Document Feeder X X
N Up 2Up Glass / Document X X (o]
Feeder
4Up Document Feeder X X X
Edge | Small Orig Glass X X X X
Erase Edges
Binder Holes| Glass / Document X X X (o]
Feeder
Book Center Glass X (0] X X
& Edges
Border Glass / Document X X (o] 0
Surround Feeder
Margin | Auto Center Glass X X X X
Shift Small Orig Only
Left Glass / Document X (o] X X (0]
Feeder Not Book Center & Edges
Right Glass / Document X (0] X X
Feeder Not Book Center & Edges
Top Glass / Document X (o] X X (0]
Feeder Not Book Center & Edges
Bottom Glass / Document X (0] X X
Feeder Not Book Center & Edges
Auto Suppress | Glass / Document X (o] (o] o (o] (o]
Feeder
Covers Glass / Document X (o] X X (o] (o]
Feeder Not Book Center & Edges| Not Auto
Center
Transparencies | Glass / Document X (o] X X o (o] o X
Feeder Not Auto
Center
R/E % Glass / Document X 0 X X (0] X o (o] (0]
Feeder Binder Holes & Border
Surround Only
AutoFit Glass X X X X (o] X (0] X (o]
Small Orig Only
Clone Glass X (0] X X
Small Orig Only
Collate Glass / Document X X X
Feeder Not Book Center & Edges
Key:
(o] Compatible
X = Incompatible
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4 Paper and Other Media

There is one Paper Tray and a Bypass Tray as standard on the
Xerox CopyCentre C20, WorkCentre M20 and WorkCentre
MZ20i. A second Paper Tray is available to purchase as an

option.
> LoadingPaper............ .. ... .. ... ... ... 4-2
> Settingthe PaperSize...................... 4-8
> Media Specifications . ...................... 4-9
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Paper and Other Media

Loading Paper

Preparing Paper for Loading

Before loading paper into the Paper Trays, fan the edges. This procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

@ To avoid unnecessary paper jams and misfeeds do not remove paper from its packaging until
required.

Using the Paper Trays

Loading the Paper Trays

Using the instructions provided, load paper into the machine. Up to two Paper Trays are
available, depending on your machine configuration. The Paper Trays can hold a maximum
of 550 sheets of 80 g/m? (20 Ib) plain paper.

o > To load paper, pull open the

Paper Tray.

@ > Push down on the pressure plate
until it locks into position.
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4,

® [f you experience
problems with
paper feed, turn
the paper around
and ifthe problem
continues, use
the Bypass Tray.

> Adjust the rear paper guide to the
required paper length.

It is preset to A4 or Letter size
depending on country.

» To load another size, lift the rear
guide out of the current position
and into the required position.

@® The Paper Trays can hold a
maximum of 550 sheets of 80 g/m2
(20 Ib) plain paper. You can use

A4, Letter or Legal size paper only.

> Fan the paper and insert it into
the tray.

If loading Letterhead, ensure the
design is face-up and the top
edge of the sheet is placed at the
right side.

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide
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Paper and Other Media

6

o When printing
from your PC,
ensure you select
the Paper Source
and the correct
paper size from
your software
application.

> Ensure that the paper is
positioned under the snubbers.

=\y Corner
M snubbers

» Do not fill above the Maximum Fill
Line.

Max Fill
Line

> Position the side guide by
squeezing the lever and sliding it
toward the stack of paper, until it
gently touches the side of the
stack.

Do not allow the guide to press
against the edge of the paper
tightly.

> Close the Paper Tray.

@ Use the instructions “Setting the Paper Size” on page 4-8 to set the correct size for the Paper
Tray.

Page 4-4
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6 > To select a paper tray, press the

[Paper Supply] key until the
required tray is lit on the Status
Map.

Tray 1 and the Bypass Tray are
available as standard, Tray 2 is
optional.

If two tray lights display together,
the Auto Tray Switching feature is
active. When one tray runs out of
paper, the machine will switch to

the other selected tray.

Using the Bypass Tray

Paper Supply

The Bypass Tray is located on the right side of your machine. It can be closed when not in
use, making the product more compact. Use the Bypass Tray to print transparencies, labels,
envelopes or postcards in addition to making quick runs of paper types or sizes that are not
currently loaded in the paper tray.

Acceptable print media is plain paper with sizes ranging from 98 x 148 mm (3.86 x 5.83 inch),
to Legal size (216 x 356 mm/ 8.5 x 14 inch) and weighing between 60 g/m? and 160 g/m? (16

Ib and 43 Ib).

The following table summarizes the print media allowed and the maximum stacking height for

each paper type.

PAPER TYPE

MAXIMUM STACKING HEIGHT

printed Paper

Plain/Bond/Colored and Pre-

100 sheets or 9 mm (0.35 inch)

Envelope 10 envelopes or 9 mm (035 inch)
Transparency 30 sheets or 9 mm (0.35 inch)
Label 10 sheets or 9 mm (0.35 inch)
Cardstock 10 sheets or 9 mm (0.35 inch)

@ The height is measured with the stack of sheets laid on a flat surface.
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Paper and Other Media

Loading the Bypass Tray
® Remove any curl > Lower the Bypass Tray, located
on posteards, on the right side of the product.
envelopes, and
labels before
loading them into > Unfold.the Paper Support
the Bypass Tray. extension.
Paper
Support
> Prepare a stack of paper or
envelopes for loading by flexing
or fanning them back and forth.
Straighten the edges on a level
surface.
e Hold _ > Load the print material with the
Zf”s"ar encies by print side facing down and
e edges and ) .
avoid touching against the right edge of the tray.

the print side.

> Adjust the paper guide to the
width of the stack of print
material.

Ensure you have not loaded too
much print media. The stack
should be under the Max. Fill
Line.
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6 > To select the Bypass Tray, press
the [Paper Supply] key until the
Bypass tray is lit on the Status
Map.

> When the Bypass Tray is
selected the Paper Type option
displays. Use the Navigation
Keys to select the Paper Type
being loaded and press [Enter].

Status Map

Paper Supply

@ Use the instructions “Setting the Paper Size” on page 4-8 to set the correct size for the Bypass

Tray.

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide
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Paper and Other Media

Setting the Paper Size

O & o9

After loading paper in the Paper Trays, you will need to set the default Paper Size. Use the
following instructions to set the default Paper Size for each tray.

> Press the [Machine Status] key on the Control Panel.

> Select [Machine Setup] using the Navigation Keys and press [Enter].
The display shows [Tray 1 Size] on the bottom line.

> Press [Enter].

> Use the Navigation Keys to select the Paper Size required and press [Enter] to save the
selection.

> Repeat the procedure for [Tray 2 Size] if available, and [Bypass Size].

> Press [Menu/Exit] to exit each menu level and return to Standby mode.
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Media Specifications

Media Sizes and Types

The table below identifies the media sizes which can be used in the Paper Tray and Bypass

Tray, and the capacities which can be loaded.

MEDIA SIZE INPUT SOURCE CAPACITY?
Paper Tray Bypass Tray

Plain paper
Letter (8.5 x 11 inch) YES 550 YES 100
Folio (8.5 x 13 inch) YES 550 YES 100
Legal (8.5 x 14 inch) YES 550 YES 100
Executive (7.25 x 10.5 inch) NO 0 YES 100
A4 (210 x 297 mm) YES 550 YES 100
B5 (182 x 257 mm) NO 0 YES 100
A5 (148 x 210 mm) NO 0 YES 100

Envelopes
No. 10 (8.5 x 14 inch) NO 0 YES 10
C5 (6.38 x 9.37 inch) NO 0 YES 10
DL (110 x 220 mm) NO 0 YES 10
Monarch (3.87 x 7.5 inch) NO 0 YES 10
B5 (176 x 250 mm) NO 0 YES 10
Labels®
Letter (8.5 x 11 inch) NO 0 YES 10
A4 (210 x 297 mm) NO 0 YES 10
Transparency films®

Letter (8.5 x 11 inch) NO 0 YES 30
A4 (210 x 297 mm) NO 0 YES 30

Card stocks®
A6 (105 x 148.5) NO 0 YES 10
Post Card (4 x 6 inch) NO 0 YES 10
Hagaki (5.83 x 8.27 inch) NO 0 YES 10

® a Depending on paper thickness, maximum capacity may be reduced.
b. Feed one sheet at a time through the Bypass Tray if jams occur.
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Paper and Other Media

Media Guidelines

When selecting or loading paper, envelopes, or other special media please adhere to these
guidelines:

> Attempting to print on damp, curled, wrinkled, or torn paper can cause paper jams and
poor print quality.

> Use only high quality copier grade paper. Avoid paper with embossed lettering,
perforations, or texture that is too smooth or too rough.

> Store paper in its ream wrapper until ready to use. Place cartons on pallets or shelves, not
on the floor. Do not place heavy objects on top of the paper, whether it is packaged or
unpackaged. Keep it away from moisture, or other conditions that can cause it to wrinkle or
curl.

> During storage, moisture-proof wrap (any plastic container or bag) should be used to
prevent dust and moisture from contaminating your paper.

> Always use paper and other media that conform with the specifications detailed in
“General Specifications” on page 12-6.

> Use only well-constructed envelopes with sharp, well creased folds:
- DO NOT use envelopes with clasps and snaps.

- DO NOT use envelopes with windows, coated lining, self-adhesive seals, or other
synthetic materials.

- DO NOT use damaged or poorly made envelopes.
> It is recommended that you feed special paper types one sheet at a time.
> Only use the special media recommended for use in laser printers.

> To prevent special media such as transparencies and label sheets from sticking together,
remove them from the exit tray as they are printed.

> Place transparencies on a flat surface after removing them from the machine.

> Do not leave the film in the paper tray for long periods of time. Dust and dirt may
accumulate on them resulting in spotty printing.

> To avoid smudging caused by fingerprints, handle transparencies and coated paper
carefully.

> To avoid fading, do not expose the printed transparencies to prolonged sunlight.

> Store unused media at temperatures between 59°F and 86°F (15°C to 30°C). The relative
humidity should be between 10% and 70%.

> Do not load more than 10 sheets of special media into the Bypass Tray at a time.
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> Verify that your labels’ adhesive material can tolerate fusing temperature of 200°C (392°F)
for 0.1 second.

> Ensure that there is no exposed adhesive material between labels. Exposed areas can
cause labels to peel off during printing, which can cause paper jams. Exposed adhesive
can also cause damage to machine components.

> Do not feed a sheet of labels through the machine more than once. The adhesive backing
is designed for one pass through the machine.

> Do not use labels that are separating from the backing sheet or are wrinkled, bubbled, or
otherwise damaged.
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5 E-mail

The E-mail function is available as standard on the Xerox
WorkCentre M20i and as an option on the Xerox WorkCentre

M20.

Y V VY V

SendinganE-mail . .. ............ ... ... ....
Basic E-mail Features . ... ..................
Special E-mail Features. . . ..................
Using the Global Address Book. . ............
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Sending an E-mail

E-mail

The E-mail function allows you to send your documents as an E-mail message without going
to a PC. The document is sent to the recipient's E-mail box as an attachment.

The document you want to send is scanned and then attached to the E-mail as an image file.
You can enter E-mail addresses by using the Alphabet Keyboard on the front of your machine,
or by retrieving them from the local address book using the Address Book key.

@ To use this function, the network and E-mail settings must be configured. A System

Administration Guide is provided with setup instructions for the E-mail. For more information
contact your System Administrator.

Document Feeder:

> Remove all staples and paper
clips prior to loading.

.
» Adjust the sliding document .
guides to the size required. Document —

Guides
> Insert the originals neatly into the

Document Feeder, face up.

The first page should be on top
with the headings towards the
back or left of the machine.

> Align the stack with the left and
rear edges of the tray. Adjust the

guides to just touch the edges of
the originals.

@®  Up to 50 sheets of 80 g/m2 (20Ib bond) paper can be loaded. Weight ranges from 45 - 105 g/m2

(12.5 - 28Ib). Sizes range from B5 to Legal (7” x 10”to 8.5” x 14” ). Refer to “Scanner and Copier
Specifications” on page 12-5 for full Document Feeder specifications.
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When using the
Document Glass,
ensure there are
no documents in
the Document
Feeder.

Leaving the
Document
Feeder open
while scanning
will affect the
image quality.

Document Glass:

» Raise the Document Feeder and
position the original face down on
the Document Glass.

Align with the registration arrow in
the rear left corner.

» Lower the Document Feeder.

@ Select the E-Mail Key and Features

Only those
features relevant
to the machine
configuration will
be available.

> Press the [E-mail] key on the
Control Panel.

> Press the E-mail feature key
required on the Control Panel.

> Basic features available for E-
mail jobs are 2 Sided, Original
Type, Color Original and
Resolution.

@ For information about all the
available E-mail features, refer
to “Basic E-mail Features” on
page 5-7, and “Special E-mail
Features” on page 5-9.

> Using the Navigation Keys, select
the setting required for the
feature and press [Enter].

Original Type  E-mail key

2 Sided

Color
Original

Resolution
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E-mail

@ Enter the Sender’s Name

® The Global

Address Book
displays
addresses
retrieved from the
system server.
For more
information about
the Global
Address Book,
refer to “Using the
Global Address
Book” on page 5-
13.

You can also
access the local
Address book by
pressing the
[Address Book]
key. Select
[Local] and press
[Enter].

» The E-mail screen displays From

or My Login Name, depending on
the authentication setting.

Enter the sender’s name using
the Alphabet Keyboard, and then
press the [Enter] key.

> If authentication has been set-up,

enter your Login Name and
Password.

(& For information about
authentication setup, contact
your System Administrator.

> The To screen displays. Enter the

recipient’s E-mail address and
then press the [Enter] key.

You can directly enter an E-mail
address using the Alphabet
Keyboard. You can include
numbers in the E-mail address by
using the Numeric Keypad.

> If you have chosen to use a Local

or Global Address Book, type in
the beginning of the E-mail
address and press [Enter].

The closest matching addresses
stored in the Address Book
display.

> Use the Navigation Keys to select

the required address and press
[Enter].

Enter the Recipient’s E-mail Address

oKl

Lwewsnswyygn
OnEDANEEDHAGE

Alphabet Keyboard Enter Key
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@ Entering Multiple Recipients

After entering the first recipient,
Another Address? displays.

> Select [Add] to add another
address or [Done] to continue. Another Address?

D
The maximum number of [Done]

addresses you can enter is 10.

> Press [Enter].

> Repeat the procedure until all
addresses have been entered.

@ Send to Myself

Send to Myself? displays.

> Select [Yes] to send a copy of the
E-mail to your own mail account.

> Select [No] if a copy is note

Send to Myself?
required.

[Yes]
> Press [Enter].

6 Review Addresses

Review Addresses? displays.

> Select [Yes] to review the

addresses you have entered, and
if necessary make changes.

Review Addresses?

I . No
> If a review is not required, select [No

[No].

> Press [Enter].
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E-mail

@ Enter a Mail Subject

Mail Subject displays.

> Enter a subject for the mailnote
using the Alphabet Keyboard.

> Press [Enter].

@ Select a File Type

Select File Type displays. Use
this option to select the type of file
you want to send.

> Select [PDF] for Portable
document Format, or [TIFF] for
Tagged Image Format.

> Press [Enter].

P Start
'@ ress Star

> Press [Start] to send the E-mail.

> If the display shows [Scan
Another?], load the next original
on the Document Glass and
using the Navigation Keys select
[Yes]. Then press [Enter].

Continue the procedure until all
the originals have been scanned.

> Select [No] when all the originals
have been scanned, and press
[Enter].

The E-mail is sent.

Mail Subject:

Select File Type
[PDF]

o
(PR E XV

b e
1 G) 8

[LER GRS

™ gy
(L0 1O

(€D RCPR b ]

Navigation Keys Start
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Basic E-mail Features

There are four basic E-mail features available. These features can be selected using the
feature keys located on the Control Panel.

2 Sided

Color Original

Original Type

Resolution

Feature Description

FEATURE OPTIONS INSTRUCTIONS
2 Sided Yes Select if your original is 2 |> Press [E-mail].
Sided. .
e Select if your > Press [2 Sided].
oinal 2 . i
gﬁg’f sare No gi:egt if your original s 1 » Use the Navigation Keys to select the option
ided. required and press [Enter] to save the selection.
Original Type Text Use for documents > Press [E-mail].
containing mostly text. i
e Use to select the J Y > Press [Original Type].
t f i i
£:u?nent being Qlxed rli?fe?:edxc:(;unrgenrgs ‘:‘/:g; » Use the Navigation Keys to select the option
scanned. grap : required and press [Enter].
Photo |Use for photographs.
Color Original On Use to scan a color > Press [E-mail].
original and send to the -
e Use to scan and recgipient » Press [Color Original].
send a color ’ L
original. > Use the Navigation Keys to select [On] and press
® The remote recipient must [Enter].
have the capability to
receive a color e-mail.
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E-mail

Resolution 100 dpi | Scans using a resolution |> Press [E-mail].
‘ of 100 x 100 dots per inch
® Use fo increase (dpi). Produces a lower
sharpness and . . .. .
clarity. quality image which can |> Use the Navigation Keys to select the option
be processed quickly. required and press [Enter].

> Press [Resolution].

200 dpi |Scans using a resolution
of 200 x 200 dots per inch
(dpi). The default setting
which produces a good
quality image from most
text originals.

300 dpi |Scans using a resolution
of 300 x 300 dots per inch
(dpi). Use this setting to
produce a higher quality
image if more definition is
required.

400 dpi |Scans using a resolution
of 400 x 400 dots per inch
(dpi). Produces high
quality output ideal for
graphics and photos. May
take longer to process.
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Special E-mail Features

The special E-mail features available can be accessed by pressing the Menu/Exit key and
then selecting E-mail Features on the display.

E-mail

Menu/Exit Enter
Navigation Keys
Feature Description
FEATURE OPTIONS TO SELECT
Group Mail New Use to create a new > Press [Menu/Exit]. Select [E-mail Features] and
Group. press [Enter].

® You can store

several E-mail > Select [Group Mail] and press [Enter].

address in a

specific Group. > Select [New] and press [Enter].

> Enter a Group Name using the Alphabet
Keyboard and press [Enter].

If a Group Name is not entered, a Group Number
displays.

» Enter an E-mail address to be included in the
Group using the Alphabet Keyboard and press
[Enter]. You can include numbers in the e-mail
address by using the Numeric Keypad. Press
[Enter].

» When the display shows [Another Address?],
select [Add] and press [Enter].

» Continue to add addresses until all the recipients
have been added to the Group, and select [Done]
and press [Enter].
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E-mail

Edit

Use to edit an existing
Group.

Delete

Use to delete an existing
Group.

> Press [Menu/Exit]. Select [E-mail Features] and
press [Enter].

> Select [Group Mail] and press [Enter].
> Select [Edit] or [Delete] and press [Enter].

> Enter a Group Number or Name and press
[Enter].

> If editing, change the Group Name, Add or Delete
addresses, and change the File Type as required.
Press [Enter].

> If deleting, a confirmation window appears. Select
[Yes] and press [Enter].

Send

Use to send E-mails to a
Group.

> Load the originals and press the [E-mail] key.

> Press [Menu/Exit]. Select [E-mail Features] and
press [Enter].

> Select [Group Mail] and press [Enter].
> Select [Send] and press [Enter].
> Enter the Group Number and press [Enter].

» Enter the Sender’s name and select other
features as required.

> Press [Start] to activate the job.
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Local Address
Book

® You can store
frequently used
E-mail
addresses in the
machine’s
memory, in the
Local Address
Book.

New Use to add entries to the |> Press [Menu/Exit]. Select [E-mail Features] and
Local Address book. press [Enter].

Edit Use to edit entries > Select [Local Address Book] and press [Enter].
GeniEiee [ dis Lees > Select [New], [Edit] or [Delete] and press [Enter].
Address book.

- > For new entries, enter the name using the
Delete  Use to delete entries from | 4, 216t Keyboard and press [Enter]. Then enter

the Local Address Book. the E-mail address and press [Enter]

> To edit or delete an entry, scroll to the required e-

mail address and press [Enter].

@ If the selected address is one of the authorized
users registered by the system administrator or an
address from Group mail, “Entry Not Editable”
displays.

> To add. edit or delete another e-mail address,

repeat the procedure.
Send |Use to send to E-mail > Load the originals and press the [E-mail] key.

addresses stored in the
Local Address book.

> Press [Menu/Exit]. Select [E-mail Features] and
press [Enter].

> Select [Local Address Book] and press [Enter].
> Select [Send] and press [Enter].

> Type the first few letters of the E-mail address
required and press [Enter]. The closest matches
display. Select the required address using the
Navigation Keys and press [Enter].

> Select another address if required. [Press Enter].

» Enter the Sender’s name and select other
features as required.

> Press [Start] to activate the job.
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Print Address | Individual |Use to print a list of > Press [Menu/Exit].
Book A indivi -mai
ddress |individual E-mail > Using the Navigation Keys select [E-mail
addresses.
® Use this feature Features] and press [Enter].
to print a list of ; ; _
individual, grou Group US? to print a list of the E > Select [Print Address Book] and press [Enter].
, group
or all E-mails Address |mail Groups.
stored in the - > Select the required option and press [Enter].
Local Address All Use to print both the . .
book. Individual and Group E- The selected list prints.
mail address lists.
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Using the Global Address Book

The Global Address Book has to be set up to retrieve E-mail address from a LDAP. The Global
Address Book works in a similar way to the Local Address Book, except you cannot add, edit
or delete users.

> Load the originals and press the [E-mail] key.
> To access the Global Address Book press the [Address Book] key and select [Global].

> Begin to enter the E-mail address in the To: field.

DO

> when a few characters have been entered, press [Enter]. The machine will search for E-
mail addresses on the LDAP server which match the characters entered.

If you have not entered enough characters, a message displays requesting more
characters.

A list of E-mail addresses which match the characters entered displays.

> Using the Navigation Keys, scroll through the list of addresses and find the correct
address. Then press [Enter].

@ > Use [Add] to enter another address if required, the maximum number of addresses you
can enter is 10.

> After entering all the addresses, select [Done] and press [Enter].

@ > Enter the Sender’s name and select other features as required.

> Press [Start] to activate the job.
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6 Fax

The Fax function is available as standard on the Xerox

WorkCentre M20i.

Faxing Procedure .........................
Dialing Methods. . .. ......... ... ... ........

Basic Fax Features . . . ......... ... ... .. ....
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ax

Faxing Procedure

o Load the Originals

Document Feeder:

> Remove all staples and paper
clips prior to loading.

> Adjust the sliding document SN

guides to the size required. Document <
Guides
> Insert the originals neatly into the

Document Feeder, face up.

The first page should be on top
with the headings towards the
back or left of the machine.

> Align the stack with the left and
rear edges of the tray. Adjust the
guides to just touch the edges of
the originals.

@®  Up to 50 sheets of 80 g/m2 (20Ib bond) paper can be loaded. Weight ranges from 45 - 105 g/m2
(12.5 - 28Ib). Sizes range from B5 to Legal (7" x 10”to 8.5” x 14” ). Refer to “Scanner and Copier
Specifications” on page 12-5 for full Document Feeder specifications.
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Document Glass:

® Ensure no » Raise the Document Feeder and

z)c;%”ﬁgtfhzr e position the original face down on

Document the Document Glass.

Feeder when . ) . . )
using the Align with the registration arrow in

Document Glass. the rear left corner.

Leaving the » Lower the Document Feeder.
Document

Feeder open

while scanning

will affect the

image quality and

toner

consumption.

® On completion of
the job, ensure
the Document
Feeder is closed.

@ Select the Fax key

> Press the [Fax] key to activate
Fax mode.

The Fax key remains illuminated
when selected.
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9 Select the Fax Features

® For more
information about > Press the Fax feature key
the available Fax required on the Control Panel. Lighten/Darken
features, refer to
Basic Fax Basic features available for Fax Original Type
Features” on . , .
page 6-8, and jobs are Lighten/Darken, 2 Sided,
“Special Fax Original Type, Color Original and
Features” on Resolution
page 6-10. ’
2 Sided
@ For.mformat/on about all the Color

available Fax features, refer to Oriainal

“Basic Fax Features” on page 6- rigina

8, and “Special Fax Features”on Resolution

page 6-10.

> Using the Navigation Keys, select
the setting required for the
feature and press [Enter].

@ Enter the Fax Number

® There are several

> Use the Numeric Keypad to enter

methods

available for the telephone number of the
entering the remote fax machine.

remote fax

number, formore 5. |f an incorrect number is entered,
information refer Ay
use the Navigation Keys to select

to “Dialing
Methods” on the incorrect number and then Numeric Keypad
page 6-6. press the correct number. Clear/Clear All

Pressing the [Clear/Clear All] key
will delete the entire fax number
entered.
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@ Press Start

> Press [Start] to begin the Fax job.

> If the display shows [Scan
Another?] and another original
requires scanning, load the next
original and select [Yes]. Press
[Enter].

Continue the procedure until all
the originals have been scanned.

> Select [No] when all the originals
have been scanned, and press
[Enter].

The Fax is scanned and sent.

@ Job Status

> To view the status of a job, press
the [Job Status] key.

> A list of current jobs and the job

1]
mon oW

e w
™

i %
(2 LOLO]
G @ D

Navigation Keys

Job Status

By

details displays.

> To add a page to a job, select the
required job using the Navigation
Keys and press [Enter]. Load the
original and select [Add Page?]
and press [Enter].

> To delete a job, select the Navigation Keys

required job and press [Enter].
Select [Cancel Job?] and press
[Enter]. A confirmation message
displays, select [1:Yes] and press
[Enter].

> Press [Menu/Exit] to exit Job
Status.
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§ Dialing Methods

There are several methods which can be used to enter a fax number or a group of fax number.
The following table identifies and explains all the dialing methods available.

DIALING METHOD

INSTRUCTIONS

machine’s memory.

Keypad Dialing > Load the originals and select the [Fax] key.
e Use when entering the remote fax | > Use the Numeric Keypad to enter the telephone number of the
number using the Numeric Keypad. remote fax machine.
> Press [Start] to send the fax.
Speed Dialing > Load the originals and select the [Fax] key.
e Use to access a fax number which | » Program the features required for the job.
has previously been stored in the > Press [Speed Dial] and enter the Speed Dial number (1-200).

The name appears and the original is scanned into memory
ready for sending.

If the original is loaded on the Document Glass, the display
asks if you want to send another page. Select [Yes] to add more
originals, or [No] to begin transmission. Press [Enter].

The fax number stored in the speed dial location will be dialed
automatically and the fax is sent.

Group Dialing

® Use fo access a group of numbers
which have previously been stored in
the machine’s memory.

Load the originals and select the [Fax] key.

Program the features required for the job.

Press [Group Dial] and enter the Group Dial number (1-200).
When the required number displays, press [Enter].

The original is scanned into memory.

If the original is loaded on the Document Glass, the display
asks if you want to send another page. Select [Yes] to add more
originals, or [No] to begin transmission. Press [Enter].

The machine automatically sends the fax to each of the
numbers in the Group.
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Manual group dialing

® Use to manually program a broadcast
send to multiple destinations.

>

>

>

>

Load the originals and select [Fax].

Press [Manual Group].

The display requests a destination fax number.
Enter the first fax number and press [Enter].

’Another No.?’ displays. Select [Yes] to add another number
and press [Enter].

Repeat the procedure until all numbers have been entered.
Then select [No] and press [Enter].

The originals are scanned and faxed to the destinations
entered.

Manual Dialing

e Use to dial the fax number with the
telephone line open.

Load the originals and select [Fax].
Press [Manual Dial].
The dial tone is audible and the LCD displays 'Phone’.

Dial the fax number. When the fax tone is heard, press [Start] to
begin faxing.

Redial

® Numbers which have already been
entered recently can be quickly
accessed using the Redial function.

Load the originals and select [Fax].
Press [Pause/Redial].

The last number is automatically dialled and the originals are
scanned and faxed.

Load the originals and select [Fax].
Press [Pause/Redial] for approximately 2 seconds.

The Redial Memory in the machine retains the last 10 numbers
dialled.

Using the Navigation Keys, select the number required and
press [Enter].

Press [Start] to dial the number. The fax is automatically
scanned and sent.
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5 Basic Fax Features

There are five basic Fax features available. These features can be selected using the feature
keys located on the Control Panel.

Original Type

Lighten / Darken

2 Sided

Color Original

Resolution

Feature Description

FEATURE OPTIONS INSTRUCTIONS
Lighten/Darken |5 Contrast Settings > Press [Fax].
e Usetoadjustthe > Press [Lighten/Darken].
contrast for a i L
document » Using the Navigation Keys select a contrast
containing faint setting.

or dark images.
Each time the key is pressed the selection block

on the display moves to the left or right. As the
selection block moves to the right the contrast
becomes darker.

> Press [Enter] to save the selection.
2 Sided Yes Select if your original is 2 |> Press [Fax].
e Select if your Sided. > Press [2 Sided].
gﬁﬂf’;’;‘f’"s arez 0D S.elect el el & > Using the Navigation Keys, select the option
Sl required and press [Enter].
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containing extremely fine
detail. This is available
only if the remote
machine also supports
Super Fine resolution.

Original Type Text Use for documents > Press [Fax].
containing mostly text. .
e Useto selectthe > Press [Original Type].
type of h i
avé)cumem being Mixed z?fefdo:ecigcaunrger:tas Vt::g; > Using the Navigation Keys, select the option
scanned. grap ) required and press [Enter].
Photo |Use for photographs.
Color Original On Use to scan a color > Press [Fax].
original and send to the i
e Use to scan and remote fax. > Press [Color Original].
send a color . L
original. > Using the Navigation Keys, select the [On] and
® The remot'e. fax must_have press [Enter].
the capability to receive a
color fax to use this
feature.
Resolution Standard |Use for documents with | > Press [Fax].
normal sized characters. .
e Use fo increase » Press [Resolution].
sharpness and i
C,a,,-g,_ Fine Usetfgr.docum(?lnts » Using the Navigation Keys, select the option
containing sma Lo required and press [Enter].
characters or thin lines.
Also used when sending a
color fax.
Super Fine|Use for documents
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§ Special Fax Features

The special Fax features available can be accessed by pressing the Menu/Exit key and then
selecting Fax Features on the display.

Menu/Exit |']-;- = p © - Enter

‘:"" A i
9 O 5

Navigation Keys

Feature Description

FEATURE OPTIONS INSTRUCTIONS
Toll Save Off Use to de-activate the > Press [Menu/Exit].
feature. . L
e Use to set a low eature » Using the Navigation keys select [Fax Features]
rate period for On Use to enable the feature.| and press [Enter].

sending faxes.
> Select [Toll Save] and press [Enter].

> Select [On] and press [Enter].

> Select [Start Time] and enter a date and time to
start the Toll Save period. Press [Enter].

> Select [End Time] and enter a date and time to
end the Toll Save period. Press [Enter].
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Memory Fax

® Use to send a
fax from
memory.

No.

Used to enter the fax
phone number for the
remote machine.

> Press [Menu/Exit].

> Using the Navigation Keys select [Fax Features]

and press [Enter].
Select [Memory Fax] and press [Enter].

Enter the fax number for the remote machine.
Press [Enter].

Another No? displays, if required enter another
number and press [Enter].

When all the numbers have been entered the
originals are scanned and stored in memory. The
fax is then sent from memory.

Delay Fax

® Use to seta
specific time for
sending your
fax.

Press [Menu/Exit].

Using the Navigation Keys select [Fax Features]
and press [Enter].

Select [Delay Fax] and press [Enter].

Enter the fax number using the Numeric Keypad
or Speed Dial, and press [Enter]. Enter another
number if required. When all numbers have been
entered select [No] and press [Enter].

Enter a name for the job and press [Enter].

The displays shows the current time, enter a time
for the delay fax and press [Enter].

If you set a time earlier than the current time, the
job will be sent at that time the following day.

The originals are scanned into memory ready for
sending.
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Priority Fax

® Use this option
to send your fax

> Press [Menu/Exit].

> Using the Navigation Keys select [Fax Features]

and press [Enter].

ahead of
reserved > Select [Priority Fax] and press [Enter].
operations.
> Enter the fax number using the Numeric Keypad
or Speed Dial, and press [Enter]. Enter another
number if required. When all numbers have been
entered select [No] and press [Enter].
> Enter a name for the job and press [Enter].
The originals are scanned into memory ready for
sending.
Polling TX Poll |Use to store a document |> Press [Menu/Exit].
on the machine ready to . .
e Poliing is used be polled by a remote fax Using the Navigation Keys select [Fax Features]
to retrieve . and press [Enter].
documents from machine.
remote fax > Select [Polling] and press [Enter].
machines.
Remote fax > Select [TX Poll] and press [Enter].
machines can
also poll your > Enter a 4 digit Poll Code and press [Enter].
machine.
> To store the originals in the Bulletin Board select
[On]. If the Bulletin Board is not required, select
[Off].
> Press [Start]. The originals are scanned into
memory ready to be polled.
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Delay RX
Poll

Use to retrieve a
document from a remote
fax machine at a specified
time.

> Press [Menu/Exit].

> Using the Navigation Keys select [Fax Features]
and press [Enter].

> Select [Polling] and press [Enter].
> Select [Delay RX Poll] and press [Enter].

> Enter the fax number using the Numeric Keypad
or Speed Dial, and press [Enter].

> The display shows the current time, enter a start
time for the remote fax machine to be polled.
Press [Enter] when the correct time displays.

If you set a time earlier than the current time, the
job will be sent at that time the following day.

> Enter a 4 digit Poll Code and press [Enter].

The machine will poll the remote machine at the
specified time.

Batch TX

® Use to send
faxes that are
going to the
same location, in
one batch.

On Activates the Batch TX
feature.
Off Deactivates the Batch TX

feature.

> Press [Menu/Exit].

> Using the Navigation Keys select [Fax Features]
and press [Enter].

> Use the Navigation Keys to select [Batch TX] and
press [Enter].

> Select [On] and press [Enter]. Enter a Batch
Interval between 0 - 99 and press [Enter].
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Fax

Mailbox

This feature allows you to store a document in a mailbox, delete a document from a mailbox,
print a document from a mailbox and to poll a mailbox. Mailboxes are setup by the System
Administrator.

(? Instructions for setting up Mailboxes are located in the System Administration Guide provided
with your Xerox WorkCentre M20i.

Storing Documents in a Mailbox

o > Load the originals you want to

store in the mailbox.

> Press the [Menu/Exit] key.

> Using the Navigation Keys select
[Mailbox] and press [Enter].

> Select [Store] and press [Enter]. Fax Features
- Mailbox
@ > Enter the box number for the

mailbox and press [Enter].

The originals are scanned and Mailbox No:
stored in the mailbox. The display

shows the number of pages

stored.
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Printing Mailbox Contents

o > Press the [Menu/Exit] key.

> Using the Navigation Keys select
[Mailbox] and press [Enter].

9 > Select [Print] and press [Enter]

9 » Enter the box number for the

mailbox and press [Enter].

> Enter the passcode for the
mailbox and press [Enter].

The contents of the mailbox are
printed and deleted.

Menu/Exit Enter

Mailbox
[Print]

Mailbox No:

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide
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Deleting Mailbox Contents

o > Press the [Menu/Exit] key.

> Using the Navigation Keys select
[Mailbox] and press [Enter].

fma
. Fad
EageTem

Menu/Exit Enter

9 > Select [Delete] and press [Enter]

Mailbox
[Delete]

9 » Enter the box number for the

mailbox and press [Enter].

> Enter the passcode for the Mailbox No:
mailbox and press [Enter].

The contents of the mailbox are
deleted.
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Polling from a Mailbox

o > Press the [Menu/Exit] key.

> Using the Navigation Keys select
[Mailbox] and press [Enter].

Menu/Exit Enter

9 > Select [Poll From] and press

[Enter]

Mailbox
[Poll From]

9 > Enter the box number to be polled
and press [Enter].

> Enter the passcode for the Mailbox No:
mailbox and press [Enter].

9 > Enter a remote fax number and press [Enter].

> The display shows the current time. Enter a start time for the mailbox to be polled and
press [Enter].

If you set a time earlier than the current time, the originals will be retrieved at that time
the following day.

The mailbox will be polled at the specified time.
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8 Sending to a Mailbox

o > Press the [Menu/Exit] key.

> Using the Navigation Keys select
[Mailbox] and press [Enter].

fma
. Fad
EageTem

Menu/Exit Enter

9 > Select [Send] and press [Enter]

Mailbox
[Send]

9 » Enter the box number for where
the originals are to be sent, and

press [Enter]. Mailbox No:
> Enter the passcode for the

mailbox and press [Enter].

9 > Enter a remote fax number and press [Enter].

> The display shows the current time. Enter a start time for the originals to be sent and
press [Enter].

If you set a time earlier than the current time, the job will be sent at that time the
following day.

The originals will be sent to the mailbox at the specified time.
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Fax Setup Options

Changing the Fax Setup Options

o > Press the [Machine Status] key.

9 > Using the Navigation Keys select
[Fax Setup] and press [Enter].

9 > Using the Navigation Keys select
the required setup option and

press [Enter].

> Using the “Fax Setup Options”
starting on page 6-20 customize
the settings to meet your
requirements.

> Press [Enter] to save your
selections.

|-

5 oty

Enter Machine
Status

Machine Setup
-2 Fax Setup

Fax Setup
[Lighten/Darken]

9 > Press [Menu/Exit] to exit each menu level and return to standby mode.
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Fax Setup Options

The following table lists all the Fax Setup options available and provides a instructions for
customizing each setting. Instructions for accessing the Fax Setup options are provided on

page 6-19.

OPTION SETTINGS DESCRIPTION
Lighten/Darken 5 Contrast Settings |Use to set the default Lighten/Darken setting.
Resolution Standard Use to set the default resolution for fax jobs.

Fine
Super Fine
Receive Mode Tel Use to operate in manual mode. When a call is
received pick up the external phone handset or
press [Manual Dial]. If a fax tone can be heard,
press [Start] and replace the handset.
Fax The machine answers the incoming call and
immediately switches to fax receive mode.
Ans/Fax Use if attaching an answering machine to the
machine. If the machine detects a fax tone, it
switches to fax mode automatically.
Fax Duplex Off Use to de-activate Fax Duplex.
Long Edge Use to set fax jobs to print 2 sided, with the
binding edge on the long edge.
Short Edge Use to set fax jobs to print 2 sided, with the
binding edge on the short edge.
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Speed Dials

New

> Enter a speed dial number using the Numeric

Keypad and then press [Enter].

If a number is already stored in the location a
message displays. Enter a different Speed
Dial number.

Enter the fax number you want to store using
the Numeric Keypad and press [Enter].

To insert a pause press the [Pause/Redial]
key and a 'P’ appears on the display.

To assign a name, enter the required name
using the Numeric Keypad. If you do not
require a name leave empty and press
[Enter].

To store more Speed Dial numbers repeat
the procedure.

Edit

Delete

If you want to delete a specific Speed Dial
number from the group, press the [Speed
Dial] key and enter the number. The display
shows [Delete].

To add a new number, press the [Speed Dial]
key and enter the number, the display shows
[Add].

Press [Enter]. Repeat the procedure until all
the editing has been completed.

Press the [Menu/Exit] key when you have
finished editing. The name appears in the
upper line of the display. Change the name
if required and press [Enter].
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Group Dials

New

> Enter a Group number between 1 and 200
using the Numeric Keypad and then press
[Enter].

If a number is already stored in the location a
message displays.

> The display asks you to enter a Speed Dial
number to add to the Group. Enter the
number and then press [Enter].

> Continue entering Speed Dial numbers until
all the group members have been added.
Press the [Menu/Exit] key when you have
finished entering numbers.

> To assign a name to the Group, enter the
required name. If a name is not required.
Press [Enter].

> To assign another Group, repeat the
procedure.

Edit

Delete

> If you want to delete a specific Speed Dial
number from the Group, press the [Speed
Dial] key. The display shows [Delete].

To add a new number, press the [Speed Dial]
key, the display shows [Add].

> Press [Enter]. Repeat the procedure until all
the editing has been completed.

> Press the [Menu/Exit] key when you have
finished editing. The name appears in the
upper line of the display. Change the name
if required and press [Enter].

MSG Confirm

On

Sets the machine to print a transmission report

for every fax transmission.

off

De-activates printing a transmission report.

On-Err

Sets the machine to print a transmission report
only if an error has occurred.
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Auto Reduction

On Use to activate the machine performing an
automatic reduction for over-sized fax jobs.
Off Use to de-activate the automatic reduction.

Over-sized jobs are printed on two pages.

Prefix Dial Up to 5 digits The number entered will be added to the
beginning of each fax sent.
Auto Report On Use to enable a report listing details about the
off previous 50 communication operations.
ECM Mode On Use to switch on ECM for all transmissions.
Transmission time may be increased when
ECM is enabled.
Off Use to switch off ECM.
Redials [0-13] Use to set the number of redial attempts.
Ring to Answer [1-7] Use to set the number of rings before
answering.
Redial Term [1-15] Use to set the number of minutes between
redial attempts.
Ringer Off Use to set the ringer volume.
Low
Med
High
Junk Fax Setup On Use to restrict receipt of junk mail by only
allowing faxes to be received from remote
Off . . .
machines registered on your machine.
Secure Receive On Use to set the default option for receiving
secure faxes.
Off
Print
Fax Auto Tray Tray 1 Selects the default paper tray for fax jobs.

Tray 1 & Tray 2

All
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Dial Mode

Tone

Pulse

Selects the default dial mode.
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7 Print

Direct Printing using a USB or Parallel Port connection is

available as standard on the Xerox WorkCentre M20 and as an
option on the Xerox WorkCentre M20i. Networked Printing is
available as standard on the Xerox WorkCentre M20i and is

optional on the Xerox WorkCentre M20.

Y V VY V

Printinga Document ... ....................
Printer Settings .. ........... .. ... ... ... ...
PCLDriver. ...... .
PostScript Driver . . .. ... ... ... ... ......
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Printing a Document

The Xerox WorkCentre M20 and M20i supports printing from these operating systems:
- Windows XP
- Windows 2000
- Windows NT V4.0
- Windows 98/Millennium Edition

Your Workstation and the Xerox WorkCentre M20 or M20i must be connected and configured
for printing from these environments.

There are two printer drivers supplied, a PostScript driver and a PCL driver.

@ Instructions for loading drivers and connecting the machine via USB or Parallel port are provided
in the Getting Started chapter. For network connections, refer to the System Administration
Guide supplied with your Xerox WorkCentre MZ20i, or contact your System Administrator.

Prior to printing, ensure all relevant connections have been made, the machine is powered on
and there is paper in the paper tray.

> Start the program you are using to create the document and create or open the document
requiring printing.

> Select [Print] or [Print Setup] from the File menu.

Ensure that Xerox WC M20 Series is selected as your default printer.

> Select [Properties] if you want to make any programming selections for your print job.

@ O

> Select [OK] to close the Properties dialog box.

@ > Select [OK] to process and send the print job.

The job will automatically be printed on your machine.
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Printer Settings

Print

Most Windows software applications allow you to make changes to the printer settings. This
includes settings that determine how a print job looks such as paper size, paper orientation,
and margins.

Settings made in the application to create the document will usually override settings made in
the printer driver.

@ You do not need to use any of the control panel keys to use the machine as a printer. For
example, if you want to adjust the printing contrast you select the settings in the printer driver,
not the Lighten/Darken feature on the machine’s control panel.

Accessing Printer Settings

You can access printer settings by using either of these methods.

Windows 98/Me
> Select File > Print > Properties or File > Print Setup from within any Windows application.
OR
> Select Xerox WC M20 Series printer from the Printers folder, then select File > Properties
(or select the printer icon in the Printers folder, and click the right mouse button).
Windows NT 4.0
> Select File > Print > Properties or File > Print Setup from within any Windows application.
OR
> Select Xerox WC M20 Series printer from the Printers folder, click the right mouse button,
then select Document Defaults from the drop-down list.
Windows 2000
> Select File > Print from within any Windows application.
OR

> Select Xerox WC M20 Series printer from the Printers folder, click the right mouse button,
then select Properties and Printing Preferences from the drop-down list.
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Windows XP

Print

> Select File > Print > Properties from within any Windows application.

> Select Xerox WC M20 Series printer from the Printers and Faxes folder, click the right
mouse button, then select Printing Preferences from the drop-down list.
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PCL Driver

Print

When the Printer Properties are displayed, the print job settings can be reviewed and
changed. The Properties window consists of six tabs:

Layout

Paper

Image Options
Output Options
Watermark

About

If the Printer Properties are accessed through the Printers folder, additional Windows-based
tabs are available.

&=

For information on the Windows-based tabs, refer to documentation provided with Windows.

For detailed information about the printer settings available on each tab, please refer to the

printer driver on-line Help.

If you access Printer Properties through the Printers folder, any settings made will become the
default settings for the printer. Settings made when Printer Properties are accessed through an
application File menu and Print or Print Setup will remain active until the application you are
printing from is closed.
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Layout Tab

~—
S

=
Q

Landscape

Use to print across the length

of the page, spreadsheet
style.

Portrait

Use to print across the width
of the page, letter style.

& Xerox WC M20 Series PCL 6 Printing Preferences

apout | Paper | Iinage Options | Dutput Options | Watemark | About
Rotate 180 Degrees s L :
SN et Favorites
Use to rotate the images 180 = Landscape
degrees. = Fiotale 180 Degrees Use this option to store
S your selections for a
] & None particular job. After making
Long Edge 5| ;E"gt:m selections, enter a job title
ort Edge
in the wi |
Use this option when you require 2 i in the Wl?g:\\'/ve?md select
sided output in a Book orientation. 210y 200 ) ’
Fiint Quantity: 1
Print-Quality: 600 dpi
Favorites Help
Printer Defaul - -
Short Edge R More Lapout Options... ] __ Use to access the
Use this option when you require 2 XEROX, H?’g)vijy:;eézt;:gzh
sided output in a Calendar ok ] [ Careel] | Coe H—— P -
rientation information about all
orientation. the Print Driver
features.
More Layout Options OK Cancel Apply
Provides access to additional layout Use to accept

features such as multiple pages per side,
poster, booklet printing, fit to page and
reduce/enlarge.

Closes the dialog and

the selections returns all settings to the

Saves all the selections
made without closing the

Page 7-6

made and values in place before the
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dialog.

dialog.
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Paper Tab

Custom

Use to enter a

customized paper size.

Type

Use to select the type of
paper required.

Size Print Quantity
Use t? select the size of paper Use to select the number of
required from the drop down . .
menu prints required.

& Yerox WC M20 Series PCL 6 Prin

Layou’t’ Paper |\magertluns Output O)

ting Preferences

Source

Use to select the required
paper source for the job.

ptlons’i‘ izt mark’,‘ About’:
Print Quantity [1-339)
44 (21014 237 mm) -
Custom
= +Printer Default hd
Cover Page
| Auta Select -
CoverPage  [Nome  —1 24 2 Use to select the required
L Print Quaniiy: 1 paper source for a cover
I Banner Shest Print-Guality: 500 dpi page.
- Favorites-
Pririter Default -
ok J[ Ceneel || s [ Hep

Banner Page

Use to select whether a banner
page is required.
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Image Options Tab

Print

Print Quality Mode

Use to select the print resolution. 1200
dpi produces the highest quality output,
300 dpi is the lowest.

& Xerox WC M20 Series PCL 6 Printing Preferences

Image Quality

Layout | Paper \ Image Options |Dutpul Options || Watermark || About |

Use to select the Image i
Quality setting to apply to @ & &0 dpi
the job. The options _ el
available depend on the i
resolution selected. Tra— ; :se Pr‘mter‘sSemng
[ ..D'ma aHce
€ I e
Toner Save Mode :

1~ Toner Save Mode

1 A4 (210 % 297 mm)
: T &0
Use to activate Toner Eﬁ»« o | Print Quantiy: 1
son Print-Qualty: 500 dpi
Save mode. Produces a sso I
. L - Favorites
lower quality output and
uses less toner.

I = L
XEROX '

I 0K H Cancel ] Apply [ Help

Graphic Options

Provides access to additional options which allow you to
select to print your output as graphics or bitmaps. You can
also select to print all text in black.
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Output Options Tab

Print Order

Use to select a sequence for your print
job. Select whether to reverse all pages,
print odd pages or print even pages.

Use Print Fonts

& Xerox WC M20 Series PCL 6 Printing Preferences

Fx
If this Option is selected Layout | Paper | Image Options | Oufput Dptions | wiatermark. | Abaut |
the fonts which are Output Dptirs
resident on the printer will ik Order - =E
be used for the job. W LUse Prirter Foris
A4 (210 x 237 mm]
Print Quantity: 1
Collate P Suslty 600 o
Favoiites
Select to produce - [PriterDetak +]
collated output s e | Ddee |
XEROX
ok J [ Cancsl ]| tepr | [ Hep
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Watermark Tab

Print

Current Watermarks

Watermarks are background images which print on each page.
They are useful for adding information such as Draft or
Confidential, or the name of your company. Select the Watermark
required from the list shown, or create a new Watermark.

& Xerox WC M20 Series PCL 6 Printing Preferences
Laout | Paper | Imags Optiors | Output Dptions | ' stermark | bout |
Add, Update and Delete " :
urrent Watermarks
Use these options to create
new Watermarks, edit
Watermarks or Delete a
Watermark.
- ! Font Attri
Watermark Messa e Watermark Message Font Attibutes o t tt bUtes
g 4 Hare it E Select the font type, style,
Use this window to enter St s Regula &l size and greyscale to use
the text you would like to Messags Angle < | B 120 = for your Watermark.
add as a Watermark fonennd Grapscale [ Medium Giay El
' T Wertical
. & Angle 45 El: Degrees
First Page Only e
o XEROX.
Select this option if you l ]
want the Watermark to print g Ji ces b
on the first page only, and

not the rest of the Message Angle
document.

Select to print the
Watermark horizontally,
vertically or a specified

angle.
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About Tab

The About Tab provides information about the printer driver. It provides the program version
number and copyright information relating to the printer driver. Clicking on this page will
connect you to the Xerox website, provided you have access to the Internet

& Xerox WC M20 Series PCL 6 Printing Preferences @EJ

Layout | Paper | Image Options | Output Options | ' atermnark | AbDUtV

THE DOCUMENT COMPANY

Capyright(c) 1998-2003 <erox Corporation
Al Right Reserved.

“ersion
Printer Driver : 1.22

ok | [ Coneel A Help
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PostScript Driver

When the Printer Properties are displayed, the print job settings can be reviewed and
changed. The Properties window consists of two tabs:

- Layout
- Paper/Quality

If the Printer Properties are accessed through the Printers folder, additional Windows-based
tabs are available.

@ For information on the Windows-based tabs, refer to documentation provided with Windows.

For details on the printer settings available on each tab, please refer to the printer driver on-
line Help.

If you access Printer Properties through the Printers folder, any settings made will become the
default settings for the printer. Settings made when Printer Properties are accessed through an

application File menu and Print or Print Setup will remain active until the application you are
printing from is closed.
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Layout Tab

Landscape Portrait
Use to print across the length  Use to print across the width
of the page, spreadsheet of the page, letter style.
style.

& Xerox WC M20 Series PS Printing Preferences

“Layolt | Paper/Qualiy|

Rotated Landscape EREEY
Onentation
Use if the image requires &) Porhait

i Land
rotating to landscape format. eneEsane

Pages Per Sheet
Riotated Landscape Use to select to print
T multiple images on one
Flip on Long Edge ® Hine sheet or to select Booklet
) Flip on Long Edge mode.
Use this option when you require 2 o shalt e
sided output in a Book orientation. Page Order ]
(%) Front to Back
Back to Front
Pages Per Sheet: | 1 AdVanCed
Flip on Short Edge (Bdvanced
Provides access to
Use this option when you require 2 i3 Cangel additional features.
sided output in a Calendar
orientation.
Page Order OK Cancel Apply
Use to print in forward or reverse  Use to acceptthe ~ Closes the dialog and
order.

selections made
and close the
dialog.

Saves all the selections
returns all settingsto  made without closing the
the values in place dialog.
before the dialog was
opened.
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£ Paper/ Quality Tab
Qa

Paper Source

Use to select the paper source for
the print job from the drop down
menu.

& Xerox WC M20 Series PS Printing Preferences

| Layout ml

Tray Selection

Paper Source:

Apply
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8 Scan

Direct Scanning using a USB or Parallel Port connection is
available as standard on the Xerox WorkCentre M20 and
WorkCentre M20i. A color scanner is provided as standard.

> TWAIN Scanner Program . .................. 8-2

» Scanning Procedure ....................... 8-3
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Scan

TWAIN Scanner Program

The Xerox WorkCentre M20 and M20i TWAIN Scanner program is used to scan images,
graphics, photographs, and printed text. Documents can be fed from the Document Feeder or
placed on the Document Glass.

The TWAIN driver is a program for PC printing that supports Windows 98, Windows NT4.0,
Windows 2000, Windows ME and Windows XP environments. Using an independent protocol
and the USB or parallel port, the TWAIN driver converts the scanned image into a standard

format that you can edit.
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Scanning Procedure

0 Open the Image Editing Application

® For instructions
on loading media, > Open your image editing

;?fer t? "Loading application and acquire the
aper” on page 4-
2 WorkCentre M20 TWAIN

Scanner.
For full media
specifications This feature allows you to convert
refer to M-ed'a,', hard copy images into electronic
Specifications”on . ’
page 12-7. images that you can use in other
documents.

@ Load the Originals

Document Feeder:

> Remove all staples and paper
clips prior to loading.

> Adjust the sliding document

guides to the size required. Document
Guides
> Insert the originals neatly into the

Document Feeder, face up.

The first page should be on top
with the headings towards the
back or left of the machine.

> Align the stack with the left and
rear edges of the tray. Adjust the
guides to just touch the edges of
the originals.

Scan
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Scan

® When using the @  Up to 50 sheets of 80 g/m2 (20Ib bond) paper can be loaded. Weight ranges from 45 - 105 g/m2
Document Glass, (12.5 - 28Ib). Sizes range from B5 to Legal (7" x 10” to 8.5” x 14” ). Refer to “Scanner and Copier
ensure there are Specifications” on page 12-5 for full Document Feeder specifications.

no documents in
the Document

Feeder.
Document Glass:
Leaving the .
Document > Raise the Document Feeder and
Ffﬁdef open position the original face down on
while scanning
will affect the the Document Glass.
image quality.

Align with the registration arrow in
the rear left corner.

> Lower the Document Feeder.

6 Select the Scan Features

® for Scanner

speciﬁcaztions > Select [New Scan] in your e WAL TMAM Sene
refer to “Scanner application to access the TWAIN TR e e e
and Copier ) . i ]
Specifications”on driver options. I rr— -

page 12-5.

> Customize the settings available
on the TWAIN driver for the job,
for example Image Input,
Resolution, and Reduce/Enlarge.

[
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@ Select Preview

> Select the Preview option on the

TWAIN driver window. e Ca ﬁ
The image appears on the (R E— -
screen. This gives you the i ET—
opportunity to select the specific b |
. R o
area you wish to scan. Spaine :
T = |
. Deiete Gewe L}
> If necessary, drag the selection oy
tool to the area requiring o® | im
scanning.
Preview

Select Scan

> Select the Scan option on the

TWAIN driver window. e oo 5 T
- ) . Iﬂwm I_li|.15‘i
The specified image displays on I
] s =l
the screen. e
M s =3
= ]
| |
e |
b
e | 30
Scan

Save the Image

> Select [File] and [Save].

The image is saved and can now
be used in another document if
required.

> Remove your original from the
Document Glass or Document
Feeder.
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9 Machine Administration

The Xerox CopyCentre C20, WorkCentre M20 or WorkCentre

MZ20i can be customised to meet individual requirements.

YV V ¥V V ¥V V VY V

Enabling or Disabling Auxiliary Access

DepartmentCodes . ......................
Passcode Protection . . ....................
ClearMemory ............ .. ... ... ....

Maintenance Tools. . . .....................
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Machine Administration

Machine Setup

Use the following instructions to customize your machine to meet your individual
requirements.

0 > Press the [Machine Status] key.

Enter Machine
Status

@ > Using the Navigation Keys select
[Machine Setup] and press

[Enter]. - Machine Setup
Fax Setup

@ > Using the Navigation Keys select
the required setup option and

press [Enter].

Machine Setup
> Using the “Machine Setup [Tray 1 Size]
Options” starting on page 9-3

customize the settings to meet

your requirements.

> Press [Enter] to save your
selections.

0 > Press [Menu/Exit] to exit each menu level and return to standby mode.
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Machine Setup Options

OPTION

SETTINGS

DESCRIPTION

Tray 1 Size

LTR/A4/LGL /Folio

Use to set the default paper size for Tray 1.
Paper Size options are Letter, A4, Legal (216 x
356 mm / 8.5 x 14 inch) or Folio.

Tray 2 Size

LTR/A4/LGL /Folio

Use to set the default paper size for Tray 2.
Paper Size options are Letter, A4, Legal (216 x
356 mm / 8.5 x 14 inch) or Folio.

Bypass Size

LTR/A4/LGL /Folio/
A5/ Statement

Use to set the default paper size for the Bypass
tray. Paper Size options are Letter, A4, Legal
(216 x 356 mm / 8.5 x 14 inch), Folio, A5 or
Statement.

®  Iffeeding media smaller than A4/Letter through
the bypass tray, the setting can remain set at
A4, Letter or Legal size.
When copying onto a paper size smaller than
A4/Letter, the printed image may be offset and
not reproduce correctly, even when Auto Fit is
selected.

Power Save

On

Off

Use to enable the Power Save feature. If On is
selected, set the period of time the machine
waits before Power Save is activated. Choose
between 5, 10, 15, 30 or 45 minutes.

Time Out

15/30/60/180
Seconds

off

Sets the number of seconds the machine
remains idle before the current job settings are
reset back to the default settings. Use Off to
deactivate the option.

Stamp RX Name

On

Off

Set to On to enable sender information, the
machine ID, the page number, the date and time
of reception and the reduction rate of the image
to be printed on each page of each received
transmission. The information is printed on the
bottom edge of each page.

Alarm Sound

On

off

Set to On to enable an alarm sound when an
error occurs or a fax communication ends.

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide Page 9-3

Machine Administration



Machine Administration

OPTION SETTINGS DESCRIPTION
Key Sound On Set to On to enable a sound when any key is
pressed.
Off
Speaker Control On The speaker can be set to On, Off or Comm.
Off Comm allows the speaker to remain on until the
remote machine answers.
Comm

Language

English, French,
German, Italian,
Spanish, Portuguese,
Dutch, Danish, Swedish,
Finnish, Norwegian,

The display uses the language selected.

Russian
Localization Inch Use to set whether measurements are
MM displayed and entered in inches or millimeters.

Select Country

UK, Greece, Turkey, Ukraine,
Slovenia, Russia, Yugoslavia,
Australia, HongKong,
NewZealand, SouthAfrica,
Israel, Korea, K.Xerox, China,
India, Asia_STD, Malaysia,
Singapore, USA/Canada,
Brazil, Chile, Columbia,
Mexico, Argentina, Peru,
Germany, France, Austria,
Switzerland, Italy, Spain,
Portugal, Norway, Finland,
Sweden, Netherlands,
Denmark, Belgium, Hungary,
Poland, Czech, Romania,
Bulgaria, Ireland

Setting the Country option sets the correct fax
communication settings for each country.

USB Mode Fast Use to set the USB speed. Fast is the default
sl mode. Some PC users may experience poor
ow USB implementation in the default mode. If this
occurs, select Slow.
Machine ID Fax Use to enter the fax number and name of the
machine.
Name
Date & Time Enter the current date and time using the

Numeric Keypad. Use Clock Mode to set
whether the machine uses a 12 or 24 hour
clock.

Page 9-4
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OPTION SETTINGS DESCRIPTION

Clock Mode 12 hour The machine can be configured to display time

using either a 12-hour or 24-hour format.
24 hour

Toner Save On If On, the machine produces a lower quality

output to reduce toner consumption. Useful if
Off L .

your machine is used for internal documents
only.

Discard Size [00 - 30] If the Fax Setup option Auto Reduction is set to

Off, and the received document is as long or
longer than the paper selected, the machine will
discard any excess image from the bottom of
the page that is longer than the selected length.

If the received page is outside the discard
margin set, it will print on two sheets of paper at
the actual size. Margins can be set between 0 -
30mm (1.2").
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Reports

Various Reports are available to assist in confirming and monitoring machine activity. Reports
can be set up to include specific information, or to print automatically.

Reports Available

Machine Administration

REPORT

DESCRIPTION

Fax Phonebook

This list contains all the numbers currently stored in the machine’s
fax phonebook as Speed Dial and Group Dial numbers.

Fax TX This report contains information about recent transmission
activities.
Fax RX This report contains information about recent reception activities.

System Data

This report shows the status of the user-selectable options. After
settings are changed, print this list to confirm your changes.

Scheduled Jobs

This list identifies the documents currently stored for Delay Send,
Priority Send, Group Dial and TX Poll operations. This list shows
the starting time and type of operation.

Fax TX Confirm

This list shows a list of confirmed fax transmissions.

E-mail TX Report

This report shows the status of E-mail transmissions.

Help List

This list shows the machine’s basic functions and commands to
use as a quick reference guide.

Junk Fax List

This list shows the fax numbers defined as junk fax numbers by
using the Junk Fax Setup menu.

Billing Counters

This report lists the billing counters and their current amounts.

Connect Page

Provides connection information for the E-mail function.

User Auth List

Provides User Authentication information for the E-mail function.

Print All Reports

Use this option to print all the available reports.
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Printing Reports

Use the following instructions to print a report.

o > Press the [Machine Status] key.

-

| et

Enter Machine
Status

> Using the Navigation Keys select
[Reports] and press [Enter].

System Admin Tools
- Reports

9 > Using the Navigation Keys select
the required report and press

[Enter].

Reports

The report is processed and [Fax Phonebook]

printed.
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ControlCentre

ControlCentre is software available for the WorkCentre M20i which enables Fax options and
features to be setup and viewed remotely using a PC.

After setting up Fax options or creating phonebooks, simply click [Apply] on the ControlCentre
screen to download the new settings to the machine.

Installing ControlCentre

When Xerox WorkCentre M20i software is installed the ControlCentre ultility is installed
automatically.

@ For information on installing refer to “Maintenance Tools” on page 9-25.

Running ControlCentre

Use the following instructions to run ControlCentre:

o > Start the Windows software.

@ » From Programs select [Xerox WC M20 Series], then [ControlCentre].

The ControlCentre screen displays.

Page 9-8
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Using ControlCentre

The ControlCentre software provides five tabs:
- Settings
- Advanced
- Phonebook
- Information
- Firmware Update
- Printer
- PCL
- Flash Font and Macro
- PostScript
To exit ControlCentre, click the [Exit] key in the bottom of each tab screen.

For further details, click the [Help] key in the bottom of each tab screen.

Machine Administration

@ When the settings on ControlCentre are changed, or when ControlCentre is run, the settings on
the machine and on ControlCentre will be automatically updated to the latest settings made
either on the machine or on ControlCentre.
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Machine Administration

Settings Tab
Click on the [Settings] tab to configure Fax settings.

ControlCentre

Reads the current
settings in the
WorkCentre M20i then
refreshes
ControlCentre with the
machine’s current
settings.

Downloads the
settings made in
ControlCentre to the
WorkCentre M20i.

Advanced Tab
Click on the [Advanced] tab to change the Machine Setup options applicable to Fax.

ContiolCentie

Page 9-10 Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide



Phonebook Tab

Click on the [Phonebook] tab to create and edit phonebook entries for use with Fax.

3 ControlCentre M Retrieves the
2 s phonebook
A Fimuare Updats | Printer | PCL | Flash Font andMacio | PostSeript | entries from the
£ Selngs | D Advanced Phonehook | 5 Infomation
e ; Xerox
iy L el WorkCentre M20i
wiz @ | to ControlCentre
Phonebook entries | [Mo. [ Mame | Phene Mumber (=]
Allows the
2 phonebook
12.] entries to be
Allows a selected i - downloaded from
phonebook entry to - ControlCentre to
be edited ’-n a ——’: Edit I @ Delete Delete Al @ [otdia. | the XerOX
separate Edit dialog WorkCentre M20i
box
=) Exit | & Help |
Deletes a selected Deletes all phonebook
phonebook entry entries

Machine Administration
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Machine Administration

Information Tab

Click on the [Information] tab to view the software version information and various counters.
The counters show how many scans and prints have been made, and how many jams have
occurred on the machine.

ControlCentre

Number of scans
using the
i Document Feeder
Number of prints
performed by the
machine
Number of scans
from the

Number of jams in the

Document Feeder Document Glass
Number of jams
Number of replaced during pri ’: ting
toner cartridges

Firmware Update Tab

Click on the [Firmware Update] tab to update the firmware of the machine.

e This feature
should be used T
by System e Hel
Administrator
only. For further
information,
please referto the
System
Administration
Guide.

Page 9-12 Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide



Printer Tab

Click on the [Printer] tab to set default print options.

ControlCentre

PCL Tab
Click on the [PCL] tab to set options for PCL printing.

ControlCentre
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Flash Font and Macro Tab

Flash PCL fonts and macros may be supplied on a CD or downloaded from the internet. Use
this tab to install flash PCL fonts and macros on the Xerox WorkCentre M20 or M20i. You can
also delete individual fonts and macros, delete all of the fonts and macros and print a font
listing.

ControlCentre

PostScript Tab

Click on the [PostScript] tab to install and manage PostScript fonts on the Xerox WorkCentre
M20 and M20i.
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Department Codes

Department Codes allow the Administrator to restrict usage and record usage data for
specified departments.

Creating Departments

o > Press the [Machine Status] key.

v
.
H

&)

=

= =
o

p |~

B o s

Enter Machine
Status

9 > Using the Navigation Keys select
[System Admin Tools] and press

[Enter].

System Admin Tools
[Passcode Protect]

> If the System Admin Tools have
already been passcode
protected, type in the password
and press [Enter].

9 > Select [Department] using the

Navigation Keys and press
[Enter].

System Admin Tools
[Department]

» Enter the Master Access Code.

(g’ The first time you access
Department, you will be
prompted to enter a master
access code then re-enter it to
confirm the code
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> Select [Set] using the Navigation
Keys and press [Enter].

> Enter a number to identify the
department and press [Enter].

Department
[Set]

> Enter a name to identify the
department and press [Enter].

> Enter the passcode for that
department and press [Enter].

> Continue to add departments as
required.

Printing Department Data

This setting is used to print two reports, a Department Code report and a Department Journal.

0 > Press the [Machine Status] key.

> Using the Navigation Keys select
[System Admin Tools] and press
[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]
already been passcode

protected, type in the password

and press [Enter].
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6 > Select [Department] using the

Navigation Keys and press
[Enter].

> Enter the Master Access Code.

[@t’ The first time that you access
Department, you will be
prompted to enter a master
access code then re-enter it to
confirm the code.

@ > Select [Print] using the Navigation
Keys and press [Enter].

> Select the required report and
press [Enter].

System Admin Tools
[Department]

Department
[Print]
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Managing Departments

1
2,

This setting is used to enable or disable Department Mode and to clear Department data and

codes.

> Press the [Machine Status] key.

> Using the Navigation Keys select
[System Admin Tools] and press
[Enter].

> If the System Admin Tools have
already been passcode
protected, type in the password
and press [Enter].

> Select [Department] using the
Navigation Keys is displayed and
press [Enter].

» Enter the Master Access Code.

@ The first time that you access
Department, you will be
prompted to enter a master
access code then re-enter it to
confirm the code.

> Select [Management] using the
Navigation Keys and press
[Enter].

System Admin Tools
[Passcode Protect]

System Admin Tools
[Department]

Department
[Management]
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@ > Select [Department Mode] using
the Navigation Keys and press

[Enter].

Management
> To enable Department Mode, [Department Mode]

select [On] and press [Enter].

@ > Select [Clear Department] using

the Navigation Keys and press
[Enter].

Management
» To clear the Journal, select [Clear Department]

[Journal] and press [Enter].

> To remove a Department Code,
select [Code] and press [Enter].

To remove all Department Codes
select [All] and press [Enter].

To remove individual Department
Codes, select [Each], press
[Enter], enter the Department
Number and confirm the removal.

Machine Administration
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Machine Administration

Changing the Master Code

1
2,

> Press the [Machine Status] key.

> Using the Navigation Keys select
[System Admin Tools] and press
[Enter].

> If the System Admin Tools have
already been passcode
protected, type in the password
and press [Enter].

> Select [Department] using the
Navigation Keys and press
[Enter].

» Enter the Master Access Code.

@ The first time that you access
departments, you will be
prompted to enter a master
access code then re-enter it to
confirm the code.

> Select [Change M. Code] and
press [Enter].

System Admin Tools
[Passcode Protect]

System Admin Tools
[Department]

Department
[Change M Code]
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@ > To change the Master Code,

select [Change] and press
[Enter].

Enter the new Master Code.

> To remove the Master Code,
select [Delete] and press [Enter].

Change M Code
[Change]
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Passcode Protection

System Administration functions can be restricted to individual users by requiring that a
passcode be entered before access to the functions can be granted.

Enable Passcode Protection

0 > Press the [Machine Status] key.

9 > Using the Navigation Keys select
[System Admin Tools] and press

[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]
already been passcode

protected, type in the password

and press [Enter].

9 > Select [Passcode Protect] using

the Navigation Keys and press
[Enter].

Passcode Protect
» To enable Passcode Protection, [Yes]
select [Yes] and press [Enter].
Otherwise select [No] and press
[Enter] to disable Passcode

Protection.

@ When the machine is first installed, the passcode is blank. When you choose Yes, you will be
asked to enter the passcode. Simply press [Enter] when requested to enter the passcode.

> If you enabled Passcode Protection, refer to “Change the Passcode” starting on page 9-23
to enter the new passcode.
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Change the Passcode

This procedure is used to change an existing passcode or to enter a passcode after Passcode

Protect has been enabled.

o > Press the [Machine Status] key.

@ > Using the Navigation Keys select
[System Admin Tools] and press

[Enter].

> If the System Admin Tools have
already been passcode
protected, type in the password
and press [Enter].

9 > Select [Change Passcode] using

the Navigation Keys and press
[Enter].

> Enter the existing passcode and
press [Enter].

(& This will be blank if you have just
enabled Passcode Protection

9 > Enter the new passcode and

press [Enter].

System Admin Tools
[Passcode Protect]

System Admin Tools
[Change Passcode]

Enter Passcode:
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Clear Memory

This tool is provided to let you clear the data from selected areas of memory. For Fax, you can
clear the phonebook and both receive and transmit history data; for E-mail, you can clear the
address book and transmit data; and you can clear the system data.

Clearing the Memory

o > Press the [Machine Status] key.

@ > Using the Navigation Keys select
[System Admin Tools] and press

[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]
already been passcode

protected, type in the password

and press [Enter].

9 > Select [Clear Memory] using the

Navigation Keys and press
[Enter].

Clear Memory

> Select the option required and [Fax Phone Book]

press [Enter].

The choices are:
Fax Phone Book
Fax RX History
Fax TX History
System Data
Email TX History
Email Address Book
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Maintenance Tools

A number of maintenance tools are provided in System Admin Tools:

Serial Number
Notify Toner Low
New Drum
Clean Drum

Billing Counters

@ These tools can also be accessed using Xerox CentreWare, refer to the System Administration

Guide for more information.

Check the Serial Number

O -

>

>

Press the [Machine Status] key.

Using the Navigation Keys select
[System Admin Tools] and press
[Enter].

If the System Admin Tools have
already been passcode
protected, type in the password
and press [Enter].

System Admin Tools
[Passcode Protect]
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>

>

>

Select [Maintenance] and press
[Enter].

Maintenance
[Serial Number]

Select [Serial Number] and press
[Enter].

The serial number of the Xerox
WorkCentre M20 or M20i is
displayed.

Press [Menu/Exit] to exit this
function.
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Notify Toner Low

If the Notify Toner option is set to On, when the toner cartridge needs to be replaced, the
machine automatically sends a fax to the service company or the dealer to notify them that the
machine requires a new toner cartridge. This feature will be activated only when the phone
number of the service company or the dealer is stored in the machine’s memory.

o > Press the [Machine Status] key.

9 > Using the Navigation Keys select
[System Admin Tools] and press

[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]
already been passcode

protected, type in the password

and press [Enter].

9 > Select [Notify Toner Low] and

press [Enter].

Maintenance
[Notify Toner Low]

9 > Select [On] and press [Enter].

> When prompted, enter:

Notify Toner Low

Your Customer Number
[On]

Your Customer Name
The Supplier's Fax Number
The Suppliers Name

Machine Administration
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New Drum

This function is used to reset the drum counter after the drum has been replaced.

o > Press the [Machine Status] key.

@ > Using the Navigation Keys select
[System Admin Tools] and press

[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]
already been passcode

protected, type in the password

and press [Enter].

9 > Select [New Drum] and press

[Enter].

» To set the drum counter to zero,
select [On] and press [Enter].
Otherwise, select [Off] and press
[Enter] to exit the selection.
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Clean Drum

If streaks or spots appear on the prints, the drum cartridge may require cleaning. Ensure that
paper is loaded prior to selecting this option.

> Press the [Machine Status]
button.

> Using the Navigation Keys select
[System Admin Tools] and press
[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]
already been passcode

protected, type in the password

and press [Enter].

9 > Select [Clean Drum] and press

[Enter].

The Xerox WorkCentre M20 or
M20i will print a special cleaning
page.

System Admin Tools
[Clean Drum]

Machine Administration
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Billing Counters

Billing can display the contents of a number of counters used in the WorkCentre M20i. These
counters are:

1
0 .

>

©

>

Total Impressions - the total number of prints produced by the machine.

Toner Impressions - the number of prints produced by the toner.

Drum Impressions - the number of prints produced by the drum.

DADF Scan Page - the number of originals scanned from the Document Feeder.
Platen Scan Page - the number of originals scanned from the Document Glass.
Replaced Toner - the number of prints since the toner was last replaced.

Replaced Drum - the number of prints since the drum was last replaced.

Press the [Machine Status] key.

Using the Navigation Keys select
[System Admin Tools] and press
[Enter].

System Admin Tools
If the System Admin Tools have [Passcode Protect]
already been passcode

protected, type in the password

and press [Enter].

Select [Billing] and press [Enter].

Select the required Counter and
press [Enter]. System Admin Tools

[Billing]
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Enabling or Disabling Auxiliary Access

Auxiliary Access allows a foreign interface board to be recognized. Use these instructions to
enable or disable Auxiliary Access:

0 > Press the [Machine Status] key.

=

o t\*.!ul

0 ¢

| sbn A moin
D) B

Enter Machine
Status

@ > Using the Navigation Keys select
[System Admin Tools] and press

[Enter].

System Admin Tools
> If the System Admin Tools have [Passcode Protect]
already been passcode

protected, type in the password

and press [Enter].

9 > Select [Auxiliary Access] and

press [Enter].

System Admin Tools
[Auxiliary Access]

> To enable Auxiliary Access,
select [On] is displayed and press
[Enter]. Otherwise, select [Off]
and press [Enter].
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10 Maintenance

Performing the maintenance tasks enables your machine to
continue running at optimum performance. Instructions are
provided in this chapter for all the maintenance tasks required.

> Cleaning ........ ... ... ... ... . . .. . .. 10-2
> OrderingSupplies . ....................... 10-4
> Customer Replaceable Units. .. ............. 10-5
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Maintenance

Cleaning

Cleaning the Document Glass and Constant Velocity Transport
(CVT) Glass

Keeping the Document Glass clean helps ensure the best possible output. It is recommended
that the Document Glass is cleaned at the start of each day and during the day as needed.

The Constant Velocity Transport (CVT) glass is the strip of glass located to the left of the
Document Glass and is used to scan originals fed through the Document Feeder. The CVT
glass also requires cleaning.

& CAUTION: DO NOT use organic or strong chemical solvents or aerosol cleaners or

pour fluids directly onto any area. Use supplies and cleaning materials only as
directed in this documentation. Keep all cleaning materials out of the reach of
children.

A WARNING: DO NOT remove the covers or guards that are fastened with screws or
attempt any maintenance procedure that is not specifically described in this
documentation.

> Slightly dampen a soft lint-free
cloth or paper towel with water.

> Open the Document Feeder.

> Wipe the surface of the
Document Glass and CVT Glass
until they are clean and dry.

> Wipe the underside of the
Document Feeder until it is clean
and dry.

» Close the Document Feeder.
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Control Panel and LCD

Regular cleaning keeps the Control Panel and LCD free from dust and dirt. To remove finger
prints and smudges, clean the Control Panel and LCD screen with a soft, lint-free cloth, lightly
dampened with water.

Outside Areas of the Machine

Use a cloth moistened with water to clean the outside areas of the machine.
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Ordering Supplies

The Toner Cartridge and the Drum Cartridge are available as customer replaceable units.

The customer replaceable unit part numbers are listed below:

CUSTOMER PART NUMBER
REPLACEABLE UNIT
Europe USA and Canada
Toner Cartridge 106R01048 106R01047
Drum Cartridge 113R00671

To obtain supplies, contact your local Xerox representative, giving the company name, the
product number and the machine serial number.

Use the space below to keep a record of the telephone number.

Supplies Telephone Number:

#
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Customer Replaceable Units

Toner Cartridge

Expected Cartridge Life

The life of the toner cartridge depends on the amount of toner used in each printed job. For
instance, when printing a typical business letter with about 5% page coverage, expect a toner
cartridge life of approximately 8,000 pages (4,000 pages only for the toner cartridge shipped
with the machine). The actual number may vary according to the print density of the pages
being printed. If printing a lot of graphics the cartridge may require changing more often.

Toner Save Mode

The life of the toner cartridge can be extended by using Toner Save mode. The Toner Save
mode uses less toner than normal printing. The printed image is much lighter, and is adequate
for printing drafts or proofs.

Maintenance

@’ For instructions on setting the Toner Save mode refer to “Machine Setup” on page 2-19.

Replacing the Toner Cartridge

When the toner cartridge is near the end of its life, white streaks or hue change will occur. The
LCD displays a warning message ‘Toner Low’.

When the ‘Toner Low’ message appears, remove the toner cartridge and gently shake it to
temporarily re-establish the print quality. Shaking the cartridge re-distributes the remaining
toner in the cartridge. This procedure can only be performed once prior to changing the Toner
Cartridge.

> Pull the release latch to open the
side cover.

CAUTION: Ensure the side cover
is always open before opening
the front cover.
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Maintenance

2

©

e [fthe

toner gets on
clothing, wipe it
off with a dry cloth
and wash clothing
in cold water. Hot
water sets toner
into fabric.

> Open the front cover.

> Turn the cartridge locking lever
upwards to release the toner
cartridge.

To Re-distribute the Toner:

> Pull out the toner cartridge and
gently shake the cartridge to
distribute the toner evenly inside
the cartridge.

> Reinstall the toner cartridge, then
lock the lever.

» Close the front cover and the side
cover.

> The display shows [New Toner?],
select [No] and press [Enter].

The machine returns to standby.

Page 10-6

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide



6 Replacing the Toner
Cartridge:

> Shake the new toner cartridge
horizontally four or five times.

> Slide the new toner cartridge in
until it locks in place.

> Turn the toner locking lever
downwards until it locks in place.

» Close the front cover and the side
cover.

> The display shows [New Toner?],
select [Yes] and press [Enter].

The machine returns to standby.

Setting the Product to Send Toner Low Information

If the Notify Toner menu option is set to On, when the toner cartridge needs to be replaced,
the machine automatically sends a fax to the service company or the dealer to notify them that
the machine requires a new toner cartridge. This feature will be activated only when the phone
number of the service company or the dealer is stored in the machine’s memory.

Maintenance

@’ For instructions on setting the Send Toner Low Information to On, refer to “Maintenance Tools”
on page 9-25.
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Maintenance

Drum Cartridge

A

The Drum Cartridge requires replacement when the drum life warning is displayed, after
approximately 18,000 copies.

If streaks or spots are being experienced on the prints there is an option for cleaning the
drum.

@ For instructions on Cleaning the Drum, refer to “Maintenance Tools” on page 9-25.

CAUTION: Do not expose the green drum to light for an extended period. Never
expose the drum to direct sunlight or touch the drum surface. Damage or poor image
quality may result.

Replacing the Drum Cartridge

1

The useful life of the drum cartridge is approximately 20,000 copies/prints. A high rate of 2
Sided copying/printing reduces the overall life of a drum. The machine displays ‘Drum
Warning’ when the drum is near the end of life. Approximately 1,000 more copies/prints can
be made, but a replacement cartridge should be available. Replace the drum cartridge when
copy/print quality becomes degraded.

> Pull the release latch to open the
side cover.

CAUTION: Ensure the side cover
is always open before opening
the front cover.

> Open the front cover.
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® The toner > Turn the cartridge locking lever
cartridge must be upwards to release the toner
removed to .
replace the drum cartridge.
cartridge.

@ > Pull out the used drum cartridge.

> Unpack the new drum cartridge
and slide it in place, making sure

not to touch the surface of the
drum.
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Maintenance

6

> Reinstall the toner cartridge, then
lock the lever.

» Close the front cover and the side
cover.

> The display shows [New Drum
Unit?]. Select [Yes] and press
[Enter].

The machine returns to Standby
mode.

@ If the counter is not reset, ‘Drum Warning’ may appear before the new drum reaches its
maximum life. To reset the counter manually refer to the “Maintenance Tools” on page 9-25.
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11 Troubleshooting

If a problem occurs on your machine, the instructions in this
chapter will enable you to identify and clear the fault, or locate
further assistance.

> General ...... ... .. 11-2
> FaultClearance.......................... 11-3
> CustomerSupport....................... 11-10
> LCDErrorMessages. .................... 11-11
> Problem and Solutions Charts. .. ........... 11-14
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Troubleshooting

General

A variety of situations can affect the quality of the output. For optimal performance, ensure the
following guidelines are followed:

> Do not position the machine in direct sunlight or near a heat source such as a radiator.

> Avoid sudden changes in the environment surrounding the machine. When a change
occurs, allow the machine at least two hours to adjust to its new environment, depending
on the extent of the change.

> Follow routine maintenance schedules for cleaning areas such as the Document Glass
and Control Panel.

> Always set the guides in the Paper Trays to the size of the media in the tray.

> Ensure paper clips and paper debris do not contaminate the machine.

Page 11-2
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Fault Clearance

When a fault occurs, check the Status Map on the Control Panel. A red flashing LED identifies
the problem area:-

Status Map
Document
Jams
|
Paper —— Bypass
Jam /
Tray 1 T 1
! ! 1+— Tray 2

Document Jams

If a document jams while it is feeding through the Document Feeder, ‘Document Jam’ appears
on the display and the Document Jam LED on the Status Map will flash.

Details for clearing the three areas of the Document Feeder are given below.

Input Misfeed

> Open the Document Feeder top
cover.

Troubleshooting
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Troubleshooting

N

1

2

> Pull the document gently to the
right and out of the Document
Feeder.

> Close the Document Feeder top
cover.

» Feed the documents back into
the Document Feeder.

Exit Misfeed

> Open the Document Feeder and
turn the roller knob to remove the
misfed documents from the exit
area.

If the jammed document
cannot be easily removed,
skip to Roller Misfeed.

> Close the Document Feeder and
reload the documents.
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Roller Misfeed

o > Open the Document Feeder.

> Turn the release knob to enable
easy removal of the misfed
document from the exit area.
Carefully pull the document to the
right using both hands.

» Close the Document Feeder and
reload the documents.

Troubleshooting
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Troubleshooting

Paper Jams

If paper jams occur, ‘Paper Jam’ appears on the display and the Paper Jam or Paper Tray LED
on the Status Map will flash to indicate the problem area. Follow the steps below to clear the
jam. To avoid tearing paper, pull the jammed paper out gently and slowly.

Paper Feed Area

If the paper jams in the feed area 'Paper Jam O’ appears on the display.

o > Pull out the Paper Tray.
> When the tray is fully out, lift the
front part of the tray slightly to

release the tray from the
machine.

> Remove the jammed paper by
gently pulling it straight out.

» Once you remove the jammed
paper, open the side cover and
close it to clear the 'Paper Jam 0’
message from the display.

> If there is any resistance and the
paper does not move immediately

when pulled, pull the release
lever to open the side cover.

> Carefully remove the misfed
paper in the direction shown.
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@ > Close the cover.
> Insert the paper tray. Lower the
rear part of the tray to align the
rear edge with the corresponding

slot in the machine, then insert it
completely.

Paper Exit Area

If the paper is jammed in the exit area, 'Paper Jam 2’ appears on the display.

> Press the Release Lever to open
the side cover.

CAUTION: Ensure the side cover
is always open before opening
the front cover.

> Open the front cover.

> Pull down on the Fuser Lever.
This will release pressure on the

paper.
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Troubleshooting

®

» Turn the Jam Remove Lever in
the direction of the arrow to move
the paper to the exit area.

> Gently pull the paper out through
the exit area.

> Push the Fuser Lever up.

» Turn the Jam Remove Lever
back to the original position.

» Close the front cover and side
cover.
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2 Sided Jam

If a paper jam occurs in the 2 Sided module, 'Duplex Jam’ appears on the display and the
Paper Jam LED on the Status Map will flash.

> Press the Release Lever to open
the side cover.

> Remove the jammed paper.

9 » Close the side cover.

Bypass Tray Jam

If you try to print using the Bypass Tray and the machine does not detect paper due to no paper
or improper paper loading, ‘Bypass Jam’ appears on the display and the Bypass Tray LED on

the Status Map will flash.

‘Bypass Jam’ may also occur when the paper has not fed correctly in the machine.

> Open the Bypass Tray and pull
the paper out of the machine.
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Troubleshooting

Customer Support

If a fault cannot be resolved by following the LCD instructions, check the troubleshooting
tables in the next section - they may help to solve the problem quickly.

If you need further assistance or information, please visit the Xerox website for online
solutions and support:

http://www.xerox.com

If the problem persists, contact the Xerox Welcome Center or your local Xerox representative.
The serial number of the machine will be required, together with any relevant error codes.

@ For information on locating the serial number, please refer to “Customer Support” on page 1-5.

#

To access the serial number open the side cover using the release latch and then open the
front door. The serial number is located on the panel above the Toner Cartridge.

The Xerox Welcome Center or local representative telephone number is provided when the
machine is installed. For convenience and future reference, please record the telephone
number in the space below:

Xerox Welcome Center or local representative telephone number:

#

Xerox US Welcome Center:1-800-821-2797
Xerox Canada Welcome Center:1-800-93-XEROX (1-800-939-3769)
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LCD Error Messages

If an abnormal condition arises in the machine or an incorrect operation is performed, a
message indicating the nature of the error is displayed. If this happens, take the corrective
action listed in the following table.

DISPLAY MEANING SOLUTION
Bypass Jam The machine detects non |Open the side cover and remove any jammed
feeding from the bypass |paper.
tray. Load paper in the bypass tray.
Comm. Err The machine has a Try resending the fax.

problem in
communication.

Document Jam

The loaded document has
jammed in the Document
Feeder.

Clear the document jam. Refer to “Document
Jams” on page 11-3

Door Open

The side cover is not
securely latched.

Close the side cover until it locks into place.

Drum Warning

The drum cartridge is
near the end of life.

Ensure a replacement cartridge is in stock.
Replace the Drum cartridge when copy/print
quality is degraded. This may show up as dark
marks on the edge of the page. Refer to “Drum
Cartridge” on page 10-8.

Duplex Jam Paper has jammed in the |Clear the jam. Refer to “2 Sided Jam” on page
middle of 2 Sided printing. | 77-9.
Drum Empty The drum cartridge is Replace the drum cartridge. Refer to “Drum

empty

Cartridge” on page 10-8.

Fuser Error, Open Heat
Error, Heating Error and
Overheat

There is a problem in the
fuser unit.

Unplug the power cord and plug it back in. If the
problem still persists, please call for service.

Group Not Available

You have tried to select a
group.

Try again. Check location for a group.

Incompatible

Remote party did not
have the requested

feature such as polling.
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Troubleshooting

DISPLAY

MEANING

SOLUTION

Non-Xerox Toner Cart

You have used an
unauthorized toner
cartridge.

You must use a Xerox approved cartridge.

Operation Not Assigned

The machine has no job
to handle.

Line Busy The remote fax did not Try again. Contact recipient to ensure remote
answer. machine is functioning correctly.
Line Error Your machine cannot Try again. If the problem persists, wait an hour
connect with the remote | or so for the line to clear, then try again.
hi has |
machine, or has lost Or, turn the ECM mode on. Refer to “Fax Setup
contact because of a Options” on page 6-19 for more information
problem with the phone P pag '
line.
LSU Error A problem has occurred in | Try Power Off / Power On. Refer to “Powering
the LSU (Laser Scanning |On the Machine” starting on page 2-14. If the
Unit). problem still persists, please call for service.
Memory Full The memory is full Either delete unnecessary documents,
retransmit after more memory becomes
available, or split the transmission into more
than one operation.
No Answer The remote fax machine |Try again. Contact recipient to ensure remote
has not answered after machine is functioning correctly.
several redial attempts.
Poll Code Err. You have used an

incorrect poll code.

Polling Error

The remote fax machine
you want to poll is not
ready to respond to your
poll.

Or, when setting up to poll
another fax machine, you
have used an incorrect
poll code.

The remote operator should know in advance
that you are polling and have the fax machine
loaded with the original document.

Enter the correct poll code.

No Developer Cartridge

The toner cartridge is not
installed.

Install the toner cartridge. Refer to “Toner
Cartridge” on page 10-5.
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DISPLAY

MEANING

SOLUTION

No. Not Assigned

The speed dial location
has no number assigned.

paper exit area.

No Paper The recording paper in Load the recording paper in the paper tray.
the paper tray has run
out.

RX Tray Full Paper is overstacked in  |Remove paper.
the output bin.

Paper Jam 0 Paper has jammed in the |Clear the jam. Refer to “Paper Jams” on page
paper feeding area. 11-6.

Paper Jam 1 Paper has jammed in the |Clear the jam. Refer to “Paper Jams” on page
fuser area. 11-6.

Paper Jam 2 Paper has jammed in the |Clear the jam.Refer to page “Paper Jams” on

page 11-6.

Power Failure

The machine’s memory
has not been backed up.

full.

Toner Empty The toner cartridge has  |Replace with a new toner cartridge. Refer to
run out. The machine “Toner Cartridge” on page 10-5.
stops.

Toner Low The toner is almost Take out the toner cartridge and gently shake it.
empty. By doing this printing operations can be

temporarily resumed.

Retry Redial? The machine is waiting for |Press [Start] to immediately redial, or [Stop] to
the programmed interval |cancel the redial operation.
to automatically redial.

Function Full The memory has become |Either delete unnecessary documents, or

retransmit after more memory becomes
available. The transmission can also be split
into more than one operation if it is a large job.
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Troubleshooting

Problem and Solutions Charts
The following chart lists some conditions that may occur and the recommended solutions.
Follow the suggested solutions until the problem is corrected. If the problem persists, please
call for service.
Copying Problems
CONDITION SUGGESTED SOLUTION
The LCD does not turn on Check that the product is plugged into an electrical receptacle and

ensure that there is power to the receptacle.

Ensure the ON/OFF switch is in the ON position.

Copies are too light or too dark |If the original is light, use the Lighten/Darken key to darken the
image.

If the original is dark, use the Lighten/Darken key to lighten the
image.

Smears, lines, marks, or spots |If defects are on the original, press the Lighten/Darken key to
on copies adjust the image.

If no defects are on the original, clean the Document Glass and
underside of the Document Feeder.

If a line is present when using the Document Feeder and not when
using the Document Glass, clean the CVT glass. For stubborn
spots use a crumpled up piece of paper or a credit card. Refer to
“Cleaning the Document Glass and Constant Velocity Transport
(CVT) Glass” on page 10-2.

If the problem still persists, clean the Drum Cartridge. Refer to
“Maintenance Tools” on page 9-25 for instructions.

Copy image is skewed Ensure that original is positioned correctly on the Document
Glass.

Check that copy paper is loaded correctly.

Blank copies Ensure that the original is face down on the Document Glass or
face up in the Document Feeder.

Image rubs off the copy easily |Replace the paper in the tray with paper from a new package.

In high humidity areas do not leave paper in the product for
extended periods of time.
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CONDITION

SUGGESTED SOLUTION

Frequent copy paper jams

Fan the stack of paper, then turn it over in the tray. Replace paper
in paper tray with a fresh supply. Check/adjust paper guides.

Ensure that the paper is the proper paper weight 80 g/m? (20 Ib)
bond paper is recommended.

Check for copy paper or pieces of copy paper remaining in the
product after a paper jam has been cleared.

Toner yield is lower than
expected and TONER LOW
message appears in the LCD

Toner may be lodged in the cartridge. Remove the toner cartridge.
Shake the toner cartridge and tap along the top of the toner
cartridge over a waste receptacle. Take care not to touch the
exposed toner on the left side of the cartridge.

Fewer copies from the Toner
Cartridge than expected

Originals contain pictures, solids, or heavy lines. Originals are
forms, newsletters, books etc. The product is being powered on
and off frequently. The Document Feeder is being left open while

copies are being made.

Printing Problems

PROBLEM

PROBABLE CAUSE

SUGGESTED SOLUTION

The product does not
print

The IEEE-1284 parallel
cable or USB cable is not
connected properly.

Check the cable connection.

The IEEE-1284 parallel
cable or USB cable is
defective.

Check the cable with a computer and printer
that work. If printing is still not possible, replace
the cable.

The port setting is
incorrect.

Check the printer settings in the Windows
Control Panel to ensure that the print job is
being sent to the correct port. (For Example:
LPT1.)

The toner and drum
cartridges are not
installed properly.

Check that the toner and drum cartridges are
installed properly.

Reinstall the software.

The printer driver may not
be installed properly.

The parallel port cable

Use an IEEE-1284 compliant parallel port cable.

specifications may not be
correct.
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Troubleshooting

PROBLEM

PROBABLE CAUSE

SUGGESTED SOLUTION

Half of the page is blank

The page layout is too
complex.

Reduce the resolution setting from 600 dpi to
300 dpi. Install more RAM in the computer.

The page orientation may
be incorrect.

Change the page orientation in the printer setup
dialog.

Printing is too slow

The computer parallel
port may not be set for
high speed
communications.

If the computer is equipped with an ECP parallel
port, enable this mode of operation. Refer to the
Enabling High Speed Printer Communications
section of the PC’s user guide.

Computer may not have
enough memory (RAM).

Install more RAM in the computer.

Print job is too large

Reduce resolution from 600 dpi to 300 dpi.

Irregular faded patches
of print

There is a paper quality
problem.

Use only paper that meets the specifications
required by the product.

Toner may be unevenly
distributed.

Remove the toner cartridge and shake it gently
to distribute the toner evenly. Then reinstall the
toner cartridge.

Black staining

There is a paper quality
problem.

Use only paper that meets the specifications
required by the product.

Character voids

The paper may be too
dry.

Try printing with a different batch of paper.

Background scatter

The paper may be too
damp.

Try printing with a different batch of paper. Do
not open packages of paper until necessary so
that the paper does not absorb too much
moisture from the air.

Printing over uneven
surfaces.

If printing onto envelopes, change the printing
layout to avoid printing over areas that have
overlapping seams on the reverse side.

Missing characters

The paper may be too
damp.

Try printing with a different batch of paper. Do
not open packages of paper until necessary so
that the paper does not absorb too much
moisture from the air.

Back of printout is dirty

The transfer roller may be
dirty.

Print a few blank pages to clean the transfer
roller.

Incorrect fonts

TrueType fonts may be
disabled.

Use the fonts dialog box in the Control Panel to
enable TrueType fonts.
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PROBLEM

PROBABLE CAUSE

SUGGESTED SOLUTION

Faded graphics

Toner may be low.

Remove the toner cartridge and shake it gently
to distribute the toner evenly. Then reinstall the
toner cartridge.

Ensure that a spare toner cartridge is available.

E-mail Problems

PROBLEM

PROBABLE CAUSE

SUGGESTED SOLUTION

Not Assigned

The Group Mail you tried
to use has no E-mail
assigned to it.

Type the address manually.

Send Error (SMTP)

Your machine cannot
connect with the server or
has lost contact due to a
network problem.

Try again. If the problem persist, try again once
the network fault is resolved.

Recipient Address
Failure

The recipient address
could not be contacted or
is invalid.

Ensure correct address is entered.

Connection Failure

Any type of
communication or
network failure during E-
mail operations.

Try again.

Authentication Failure

Invalid Account or
Password

Ensure correct account and password are used.

Authentication

Authentication is disabled

Ensure Authentication is enabled. Refer to the

Required and the mail server System Administrator.
requires it.

SMTP Server CONN. SMTP server connection

Failure failure.

Invalid Server or Port
No.

Wrong SMTP server or
port number.

SMTP DNS CONN.
Failure.

DNS connection failure.

SMTP DNS Domain
Error

Error in the SMTP DNS
Domain.
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PROBLEM

PROBABLE CAUSE

SUGGESTED SOLUTION

E-mail Associated
Cannot Delete

Displayed when an entry
associated with group
mail is deleted from the
Address book

Remove the group mail association before
deleting the entry.

Mail Too Large

Displayed when the
machine is unable to split
the mail and send it. For
example, if the mail size is
configured to 1.0MB and
a single page is larger
than 1.0MB

Empty Address Book

Displayed when an
attempt is made to
retrieve an address from
an empty Address book.

Address Book Full

Displayed when Address
book is full with the
maximum entries.

Group Empty

Displayed when attempt
is made to delete an entry
from an empty Group.

Group is Full

Displayed when an
attempt is made to add an
entry to a Group that is full
with maximum entries.

Entry Already Exists

Displayed when entering
an entry which already
exists in the Address
book.

Invalid Email ID

Displayed when the E-
mail ID is invalid

Ensure the E-mail address does not have any
spaces in between and that it does not start with
special characters such as + or @ and that the
ID only contains one @ symbol.

Enter Again

Displayed when an
attempt is made to enter
an invalid Group number.
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PROBLEM

PROBABLE CAUSE

SUGGESTED SOLUTION

Configured Already

Displayed when an
attempt is made to
configure and already
configured Group.

Invalid Login

Displayed when Login
and/or password are
invalid or do not
correspond.

Ensure the login information and password are
valid and entered accurately.

Faxing Problems Solution Chart

PROBLEM

SUGGESTED SOLUTION

Originals are fed diagonally
(skewed)

Ensure the Document Guides are adjusted to the width of the
original being fed.

Check the original meets the conditions established for use with
this device.

The original is not being printed
on the paper of the remote Fax
even though it is being sent

Ensure the originals were placed face-up in the Document Feeder
or face-down on the Document Glass.

Originals are not sent even if
operations are carried out
normally

Check that the remote Fax is compatible with the machine. This
machine supports G3 communications but not G4
communications.

Originals cannot be received
even if [Start] is pressed

Ensure the bell rings before picking up the handset.

Ensure the handset is not replaced before pressing [Start]. When
answering a call using the handset and a Fax is being received, do
not replace the handset until [Start] is pressed and the phone line
switches to the machine.

Check the telephone cord has not been disconnected.

Check the power plug has not been unplugged from the power
outlet.

Check with the party trying to send the original that there are no
problems with the remote fax.

Paper is not collated

Ensure the machine has paper loaded.

Check if a paper jam has occurred.
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PROBLEM

SUGGESTED SOLUTION

original

The received original is printed
dark and is illegible or black
stripes are printed on the

Check with the party sending the original that the original is a
clean copy.

Check with the party sending the original that the problem is not
due to a fault or operator error at the remote Fax. For example,
dirty scan glass or dirty scan lamp.

If the same problem occurs even when copies are made on the
machine, clean the drum. Refer to “Maintenance Tools” on page 9-
25 for instructions.

Paper is collated but not printed.|Ensure there enough toner.

Check with the party sending the fax that the original was placed
correctly when scanned at the remote Fax.
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12 Specifications

Use this chapter to identify the specifications for each function

of your machine.

Scanner and Copier Specifications

YV V V¥V V VY V¥V

Introduction . . ...... ... ... .. ... L.
Printer Specifications. . ....................
Fax Specifications . . ......................
General Specifications. .. ..................

Media Specifications . . ....................

Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i User Guide

Page 12-1



Specifications

Introduction
The Xerox CopyCentre C20, WorkCentre M20 and WorkCentre M20i adhere to strict
specifications, approvals and certifications. These specifications are designed to provide for
the safety of users and to ensure that the machine operates in a fully functional state. Use the
specifications listed in this chapter to quickly identify the capabilities of the machine.
e [f further
specification
information is
required please
refer to

www.xerox.com.
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Printer Specifications

ITEM

DESCRIPTION

Emulation

PCL6

Resolution

True 600 x 600 dpi, 1200 dpi class

Printing speed

21 ppm for A4 / 22 ppm for Letter

Effective printing width

208 mm (8.2 inches) for letter / legal (216 x 356 mm / 8.5 x 14 inch)

202 mm (8 inches) for A4
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Fax Specifications

ITEM

DESCRIPTION

Applicable line

G3 PSTN (Public Switched Telephone Network)

Communication Standard

ITU G3, Super G3

Resolutions

Standard 203 x 98 dpi

Fine 203 x 196 dpi
Super Fine (Fine Photo) 300 x 300 dpi
Super Fine 203 x 392 dpi
Super Fine 406 x 394 dpi

Halftone (Error Diffusion)

Receiving Resolutions

203 x 98 dpi, 203 x 196 dpi, 300 x 300 dpi, 203 x 392 dpi, 406 x 394 dpi

Data coding

MH/MR/MMR/JBIG/JPEG (Color Transmission)

Maximum modem speed

33.6 kbps

Transmission speed

<3 seconds (Standard resolution, MMR, 33.6 kbps)

Fax Memory

16 MB

Printing speed

21 ppm (for A4) 22 ppm (letter size)

Effective scanning width

208 mm (8.2 inches)

Effective printing width

208 mm (8.2 inches) for letter / legal (216 x 356 mm / 8.5 x 14)
202 mm (8 inches) for A4

Document width and weight

Document Feeder: 176 ~ 216 mm (7 ~ 8.5 inches)

45 ~ 105 g/m? (12.5 ~ 28 Ib)

Platen: Maximum Legal (216 x 356 mm / 8.5 x 14 inch)

Input paper tray capacity

Tray 1 and Tray 2 (optional): 550 sheets 80 g/m2 (20 Ib)

Bypass Tray: 100 sheets 80 g/m? (20 Ib)

Document Feeder

Document Feeder: Up to 50 pages 80 g/m2 (20 1b)

Platen: 1 page
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Scanner and Copier Specifications

Specifications

ITEM DESCRIPTION

Scanning method CCD, Flat-bed

Copy speed 21 A4 / 22 Letter Copies Per Minute

Scan speed 2.5 msec/line MONO

Scan resolution 600 x 600 dpi, 1200 dpi class

Scan mode True Color, 250 Gray, Black and white

Copy mode Black and White

Effective scanning width 208 mm (8.2 inches)

Maximum document width 216 mm (8.5 inches)

Multi copy range 1~999

Reduction & Enlargement 25% ~ 400% in 1% increments (from Platen)
25% ~ 100% in 1% increments (from Document Feeder)

Maximum print edge margin Top, Bottom, Each side 4 mm (0.16 inch)

First Copy Out Time Under 8 seconds (Normal - Ready)
33 seconds (from Power Saver)
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Specifications

General Specifications

ITEM DESCRIPTION
Input paper tray capacity Tray 1 and Tray 2 (optional): 550 sheets 80 g/m? (20 Ib)
Bypass Tray: 100 sheets 80 g/m2 (20 Ib)

Output tray capacity

250 sheets 80 g/m2 (20 Ib), face down

Toner cartridge life

8,000 pages (for Starter Cartridge 4,000 pages) at 5% coverage

Drum life

20,000 pages (5% coverage)

Operating Environment

Temperature: 10 - 32° C/ 50 - 90° F (20 ~ 80% RH)

Paper size and weight

Trays 1 & 2: A4, Letter, Folio, Legal (216 x 356 mm / 8.5 x 14 inch
60 ~ 90 g/m? (16 ~ 24 Ib)

Bypass tray: A6 ~ Legal (216 x 356 mm / 8.5 x 14 mm)
60 ~ 160 g/m? (16 ~ 43 Ib)

Duplex: A4, Letter, Folio, Legal (216 x 356 mm / 8.5 x 14 inch)
80 ~ 90 g/m? (20 ~ 24 Ib)

Original document width and
weight

Document Feeder: 176 ~ 216 mm (7 ~ 8.5 inches)
45 ~ 105 g/m? (12.5 Ib ~ 28 Ib)

Platen: Maximum legal (216 x 356 mm / 8.5 x 14 inch)

Document Feeder capacity

50 sheets 80 g/m? (20 Ib)

Power rating

AC220 ~ 240V (Europe), 50/60 Hz 3.0A
AC110 ~ 127V (US, Canada), 50/60 Hz 6.0A

Power consumption

35 W in Power save mode
115 W in Standby mode
430 W / 420 W during operation

Weight

32 kg (Drum and Toner Cartridges included)

Dimensions (WxDxH)

540 x 441 x 488 mm (21 x 17 x 19 inches) without Tray 2
540 x 441 x 619 mm (21 x 17 x 24.4 inches) with Tray 2

Memory Size

C20 = 32MB, M20 = 32MB, M20i = 80MB
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Media Specifications
ITEM DESCRIPTION
Paper types Plain paper, OHP film, Label, Envelope, Card, Postcard
available
Paper Type Wx L (mm) W x L (Inch)
Letter 215.9x 279 8.5 x 11
Legal 215.9 x 355.6 85X 14
JIS B5 182 x 257 7.17x10.12
A4 210x 297 8.27 x 11.69
Executive 184.2 x 266.7 7.25x10.5
A5 148.5 x 210 5.85x 8.27
Paper Sizes | g card 105 x 148.5 413x5.85
Post Card 4x6 101.6 x 152.4 4x6
HagaKi 100 x 148 3.94 x 5.83
Envelope 7-3/4 98.4 x 190.5 3.88x75
Envelope COM-10 105 x 241 412x9.5
Envelope DL 110 x 220 4.33 x 8.66
Envelope C5 162 x 229 6.38 x 9.02
Custom 98 x 148 ~ 3.86x5.83 ~
215.9 x 355.6 8.5x 14
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Specifications

ITEM

Input Source

DESCRIPTION
Source Media Types Sizes Thickness
Paper Tray Plain Paper A4, Letter, Legal, 60 ~ 90 g/m?
Folio (161b ~ 241Ib)
Bypass Tray Plain Paper, A4, Letter, Legal, 60 ~ 160 g/m?
Envelope, Folio, Executive, A5, | (16]b ~ 43Ib)
Transparency, B5, A6, Monarch (7
Label, Cardstock | 3/4), COM10, #9,
C5, DL, Custom
Duplex Plain Paper A4, Letter, Folio, 80 ~ 90 g/m?
Legal (20Ib ~ 24Ib)

® B5means JIS and ISO

Transparency film thickness: 150 um
Paper Label thickness: 140 um
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